
Contents Alphabetic Index

Main Screen
Menu
Toolbar
Pedigree Screen

File
New
Open
Close
Backup
Restore
Import
Export
Print Reports
Print Setup
Database List
Exit

Data
Add Individual
Edit Individual
Edit Family
Edit Notes
Media Collection

View
Toolbar
Status Bar

Tools
Search
Merge
Preferences
Database Check/Repair

Keyboard Topics for DOS/PAF Users
Windows Keys
Keyboard Synopsis

Glossary
Glossary of Terms

Additional Help



Technical Assistance



Alphabetic Index Contents
Backup
Close
Database Check/Repair
DOS Users Keyboard Notes
Export
Family, Edit
Import
Individual, Add
Individual, Edit
Keyboard Synopsis
LDS Data
Menu
Media Collection
Merge
New Database
Notes
Open Database
Options
PAF Users Keyboard Notes
Pedigree Screen
Preferences
Printer Setup
Reports
Restore
Search
Toolbar



Menu
Ancestral Quest's main menu contains File, Data, Tools, and Help sub-menus.

The File Menu
The File menu contains housekeeping options for your database including New, Open, Close, 
Backup, Restore, Import, Export, Print Reports, and Print Setup. You will also use the File menu’s 
Exit option to quit the application at the end of a session.

The Data Menu
Use the Data menu to manipulate your records. The Data menu includes the Add Individual, Edit 
Individual, Edit Family and Edit Notes selections.

The Tools Menu
The Tools menu contains selections that will help you navigate through your database, including 
Search and Preferences, and the Merge selection, which will allow you to merge duplicate records 
within your existing database, or locate duplicates after a new database has been imported.    You 
also use the Database Check/Fix option to occassionally verify that your database is in good 
condition, and fix it if there are problems.

The Help Menu
The Help menu contains selections which will help you get more information about the Ancestral 
Quest application, including Contents, Search, and About Ancestral Quest.



Toolbar
The Toolbar provides you with quick access to most of Ancestral Quest's powerful features. Clicking 
a button in the Toolbar is identical to selecting an item in a menu, but is often more convenient. Once
you become familiar with the buttons and what they represent, you will find that using these buttons 
is much faster than selecting options within menus.

The Ancestral Quest Toolbar

Opening an Existing Database
Clicking the Open button in the Toolbar is identical to selecting Open in the File menu. 

Open Button

Use this button to easily open an existing family database.

Importing GEDCOM Files
Clicking the Import button in the Toolbar is the same as selecting Import in the Data menu.

Import Button

Use this option to select a GEDCOM file and open it within Ancestral Quest.

Exporting GEDCOM Files
Clicking the Export button in the Toolbar is the same as selecting Export in the Data menu.

Export Button

Use this option to select exiting data and export it as one of the three types of GEDCOM file.

Printing
Click the Print Reports button to open the Reports window.

Print Reports Button

Use the Reports window to select specific report formats that you would like to use to print database 
information.

Adding an Individual
Click the Add New Individual button to open the Add New Individual window.

Add Individual Button

Use the Add New Individual window to define specific information about an individual and add he or 
she to your pedigree chart.

Editing an Individual
Click the Edit Individual button to reopen an existing information file, and change or add information.

Edit Individual Button

Clicking the Edit Individual button is the same as selecting Edit Individual in the Data menu.

Editing a Family



Click the Edit Family button to open a new or existing family information file, and change or add 
information.

Edit Family Button

Clicking the Edit Family button is the same as selecting Edit Family in the Data menu.

Editing Notes
Click the Edit Notes button to access notes for the selected individual.

Edit Notes Button

Clicking the Edit Notes button is the same as selecting Edit Notes in the Data menu.

Multimedia Collection
Clicking the Media Collection on the Toolbar is the same as selecting Media Collection in the Data 
menu.

Media Collection Button

Use this button to access the Multimedia collection for the currently selected individual.

Searching a Database
Clicking the Search button in the Toolbar is the same as selecting Search in the Tools menu.

Search Button

Use this option to open the Find Individual window and perform a search, by RIN, for an individual, 
or browse the entire list of individuals.

Merging Files within Your Database
Clicking the Merge button in the Toolbar is the same as selecting Merge in the Tools menu.

Merge Button

Use this option to open the Merge window.



root
Same as the primary



Pedigree Screen
The main pedigree screen is a 5 generation pedigree of the person in the root, or primary position.
Only while on this screen will you have access to the menus and toolbar.    While on any of the other 
screens, the menus and toolbar will be unavailable, even if they are visible.

Navigating
You will find navigating through your data to be an easy task from the pedigree screen. To move to 
the right in your family tree, you can select one of the right arrows. Once you have moved to the 
right, Ancestral Quest will remember where you came from, and a left arrow next to the primary 
person on the chart will let you go back the way you came.
The ANCESTOR arrow will only be available if the ancestry extends beyond the fifth generation of the 
screen. The DESCENDANT arrow will only appear next to the first generation if Ancestral Quest can 
determine the path you have traveled to that point – it is not merely an indicator that there are 
descendants for the primary individual.

Changing the primary
Navigating with the keyboard

InfoBox
As you move the mouse over a name on the pedigree screen, an information box will appear, if that 
option is turned on.    How quickly it drops depends on your preference selections.    (See InfoBox 
preferences for more details on how to control the InfoBox.    As you move the mouse away from the 
name, the InfoBox will go away, unless you have locked it.
To change the primary individual, simply double-click the box containing that individual’s name. The 
pedigree will shift to display the newly selected individual as the root, or primary, of the pedigree.
Many of the menu and toolbar options act on the currently selected person on the pedigree.    You 
will want to make sure that you have selected the appropriate person prior to initiating a menu or 
toolbar option.

Secondary Mouse Button Quick Access
You can now position the cursor over any name on the main pedigree screen, and click the 
secondary (windows default is the right) mouse button.    This will provide a quick access menu to 
several actions you may want to take for the individual, including showing the default photo.
Secondary mouse button quick access menus are available in both the main pedigree screen, and 
the Family edit screen (where most of your information input takes place).    You will find that 
navigating and data entry is very fast and convenient with this powerful feature.
You place the tip of the mouse cursor on any individuals name, click the secondary mouse button 
(usually the right button), and a drop-down menu will appear, allowing you to take one of several 
actions for the individual.    This will also cause the infobox to go into the locked state.

Notes Indicator
Once you have entered notes for an individual, a triangle will appear in the corner of the name box.   
If no triangle is present, then no notes have been saved for that individual.

Indicates Notes Present

Multimedia Indicator
Once you have entered any multimedia object for an individual, a small box will appear in the upper 
right corner of the name box.    If no small box is present, then no media objects have been saved for
that individual.



Indicates Presence of Media Objects

If you see both the triangle, and the little box, then both notes and media are associated with the 
individual.



Glossary of Terms
Ahnentafel
Ancestral File Number (AFN)
database
deleted record
default
GEDCOM
given names
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primary
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RIN
selected individual
surname
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Keyboard Synopsis
Although all of the menu commands and selections are accessible simply by pointing the mouse and
clicking, there may be times when you will need to access the major features of the application 
without a mouse, or simply would prefer not to use one.
Remember, the underlined letter of every menu selection can be used when a menu is open. In 
windows such as the Preferences window, you can tab through sections of the window and use the 
underlined letter of the available options in combination with the Alt key on your keyboard, to select 
and deselect radio buttons and checkboxes, using the letter within the selection that is underlined.
Use Tab, not Enter to move between fields. Enter will activate the button in the window with 
the thick border. Look on the menus for keyboard shortcuts such as Ctrl+O for Open. 
Whenever you see a letter with an underscore, use Alt + the underscored letter to activate.
Use Escape (Esc) to close most windows. Drop down boxes are opened using Alt+ the down 
arrow, and closed with Alt + the up arrow.
Use the Tab key to access a group of radio buttons, then use the arrows to select the radio 
button you desire.
This table contains the available Control-key keyboard equivalents. Keyboard equivalents that use 
the Control (CTRL) key make it possible to access menu selections from within the application 
without opening the menu.

Keystr
oke

Equivalent Available From Description

CTRL+
O

Open Main Pedigree Open an existing database

CTRL+
R

Print 
Reports

Main Pedigree Print the database as a 
specific type of report

CTRL+
A

Add 
Individual

Main Pedigree Add a new individual to the 
database

CTRL+
I

Edit 
Individual

Main Pedigree Edit information about an 
existing individual

CTRL+
F

Edit Family Main Pedigree Add or edit family information 
for an individual

CTRL+
N

Edit Notes Main Pedigree Add or edit notes for an 
individual

CTRL+
S

Search Main Pedigree Open the Search window to 
locate specific individuals 
within the database

CTRL+
P

Preference Main Pedigree Open the Preferences window

CTRL+
Z

Undo Any Edit Field Undo the last editing keystroke

CTRL+
X

Cut Any Edit Field Cut information out of a Notes 
window or text field and place 
in the clipboard

CTRL+
C

Copy Any Edit Field Copy information out of the 
Notes window or text field and 
place in the clipboard

CTRL+
V

Paste Any Edit Field Paste information that has 
been cut or copied to the 



clipboard into the Notes 
window or any field

F1 Help Any Screen Opens the Contents Help 
window

F7 Ditto 
Primary

Individual and Notes   
Screens when editing 
parent or spouse from
Family screen.

Dittos data from primary 
person on Family screen.

F8 Ditto Last 
Record

Individual, Notes and 
Marriage screens

Ditto data from last edited 
record

SHFT+
F8

Ditto 
Father

Individual and Notes 
screens

Ditto data from father

CTRL+
F8

Ditto 
Mother

Individual and Notes 
screens

Ditto data from mother

ALT+F
8

Ditto Older 
Sibling

Individual and Notes 
screens

Ditto data from next older 
sibling

F9 Ditto Down Individual, Notes and 
Marriage screens

Ditto from first non-blank field 
above of same type



LDS Data
This appendix explains the Use LDS Data option available in the Preferences window, and the 
places in the Ancestral Quest application where LDS Data will be applicable. It also helps you 
understand all of the fields within the database associated with LDS Data, and how to enter 
information in those fields correctly.
Here’s how to turn on the LDS Data option.
1. Select Preferences in the File menu.
2. Within the Preferences window, select the Use LDS DATA option by clicking its checkbox.
3. Close the Preferences window.

The LDS Data option may be turned on and off, as necessary.
The following special codes are allowed in the date fields pertaining to LDS ordinances:
• Enter Infant, Inf, Child, or Chi, in the Baptism and Endowment date fields to indicate that since 

the child died before the age of 8, the ordinance is not necessary
• Enter Stillborn or Sti, in the Baptism, Endowment, and Seal to Parents date fields, to indicate 

that the ordinance is not needed 
• Enter BIC in the Seal to Parents date field to indicate that the child was “Born In the Covenant” 

to parents whose marriage was sealed in the Temple, prior to the birth
• Enter Canceled, Can, DNS, or DNS/CAN in the Seal Wife to Husband date field in the Marriage 

window, to indicate that the ordinance has been canceled, or should not be performed (Do Not 
Seal). DNS can also be entered in the Sealed to Parents date field.

• Enter Submitted or Sub, to indicate that the name has already been submitted to have the 
temple ordinance work done. This entry is valid for any of the ordinance date fields

• Enter Cleared or Cle, to indicate that the name has been submitted, as above, and that 
notification has been received that the work has been done (cleared). This entry is valid for any 
of the ordinance date fields

• Enter Uncleared or Unc, to indicate that the name has been submitted, but has not been 
cleared. This entry is valid for any of the ordinance date fields

• Enter Completed or Com, to indicate that you have received confirmation that the ordinance 
work has been done, but you do not know the date. This entry is valid for any of the ordinance 
date fields.

For compatibility with PAF version 2.31, the following codes are also available (if you have a 
version earlier than 2.31, and wish to retain compatibility, do not use these):

• Enter Pre-1970 in any ordinance field to indicate that the work might have been done.
• Enter Done in any ordinance field to indicate that the work has been done.

LDS Data in the Information Window
If you have selected to use LDS data, the following additional information may be added to an 
individual’s information window.

Baptism
The date of baptism should be entered using the standard date format of dd mmm yyyy. If one of 
the date options described above applies, a special date code may be used instead of an actual 
date.
Use the text field to the right of the Baptism field to enter the location where the baptism took place. 
If baptism occurred in the Temple after the individual’s death, you can select the Temple where the 
ordinance was performed by scrolling through the pop-up Temple menu. Open the Temple menu by 
clicking the down-pointing arrow to the right of the place field. 



Endowment
The date of endowment should be entered using the standard date format of dd mmm yyyy. If one 
of the date options described above applies, a special date code may be used instead of an actual 
date.
Use the text field to the right of the Endowment field to enter the Temple where the individual took 
out their endowments. You can select the Temple where the ordinance was performed by scrolling 
through the drop-down Temple menu. Open the menu by clicking the down-pointing arrow to the 
right of the place field. 

Sealed to Parents
The date that an individual was sealed to his or her parents should be entered using the standard 
date format of dd mmm yyyy. If one of the date options described above applies, a special date 
code may be used instead of an actual date.
Use the text field to the right of the Sealed to Par field to enter the name of the Temple where the 
sealing took place. You can select a Temple by scrolling through the pop-up Temple menu. Open the 
Temple menu by clicking the down-pointing arrow to the right of the place field. 

Understanding Ordinance Abbreviations
If an ordinance has been performed for an individual, an ordinance abbreviation is displayed within 
the additional information window on your pedigree. Ordinance abbreviations provide you with a 
quick reference to the ordinances that have been performed for an individual.
The letters “B,” “E,” “S,” “C,” and “P” are abbreviations for Baptism—B, Endowment—E, Sealed to 
Spouse—S, Child Ordinances—C, and Sealed to Parent—P. In order for the Child Ordinances code 
to be displayed, all ordinances for all children of a person must be completed. Each child must be 
Baptized, Endowed, sealed to Parents, and if married, sealed to all Spouses.



RIN
Record Identification Number. The number given automatically to an individual record to identify it.



MRIN
Marriage Record Identification Number. The number given automatically to a marriage record to 
identify it.



Valid Range
The lowest and highest record numbers available.



Deleted Record
A record that has been deleted.    This record number is not currently valid, but will be reused as new
records are added.



Tag
A tag is a word associated with a body of notes to identify it as relating to a specific topic.    To qualify
as a tag, the word must be the first word in a note, and start at the beginning of the first line of the 
note -- no leading spaces or tabs.    The recommended format is all caps, ending with a colon.    Ex:    
“BIRTH:”.    Finally, to qualify as a tag, the text must be separated from the attached information by a 
space, Ex:    “BIRTH: She was breach.”, not “BIRTH:She was breach.”
If a tag starts with an exclamation point (!), it is considered a Source Note (ex: !BIRTH:).    Its 
purpose is to document where information on the event can be found.    Many reports, as well as 
GEDCOM exporting, allow you to distinguish between Source notes and other notes.
Some tags qualify as Control Notes, notably TELEPHONE:, MAILADDRESS: and 
CONTACT_NAME:.    These special tags are used by Ancestral Quest in generating phone and 
address contact lists.    Several reports allow you to hide these, as the information contained in them 
might be considered confidential.



Ancestral File Number
A number assigned by the general Ancestral File database to identify an individual.



Database
A group of records that can be accessed, altered, saved, and shared. In Ancestral Quest, these 
records are stored in a group of 7 files that are common to the PAF database, and 2 more that are 
used only by Ancestral Quest.
Only 1 database can exist in a single directory.



Default
Default selections are the options selected at the factory that appear after initial installation of the 
software.



GEDCOM
GEnealogical Data COMmunication. A database format supported by many genealogical database 
applications.



Given Names
A given name is the name an individual is given at birth. It is the name that appears on the 
individual’s birth certificate. It is not a nickname, or legally changed name.



Keyboard Equivalent
Keyboard equivalents are buttons on your keyboard that duplicate the functions of certain menu 
selections.



Pedigree
A pedigree is a visual representation of several generations. A pedigree is usually set up to look 
much like a tree, with one individual as the “root” or primary individual, with several branches of 
family attached to the right, to create a “family tree.”



Primary
The primary individual is the person you have selected to be the “root” of your family tree. In 
Ancestral Quest, the primary individual is the person to the far left of the pedigree.
The primary marriage is used only in the family screen.    This is the marriage of the primary 
individual and the currently selected spouse.
On the merge screen, the primary individual is the one on the left.    If the merge is performed, this is 
the individual who will remain in the database.    The duplicate individual will be deleted.



Record
Each individual saved within your database is a “record.” A database consists of many records. Each
record is identified by the PAF database by its RIN (or MRIN).



Surname
An individual’s surname, is his or her last name. In the name Thomas P. Morgan, Morgan is Thomas’
surname.



Title
A title is typically given to an individual to show respect. Titles can include military honors such as 
Colonel, or Commander, government offices such as Mayor or Governor, or religious titles, such as 
Pastor, Bishop, or President.



Changing the Primary - Pedigree
While on the pedigree screen, there are several ways to change the primary person:

Double-click the person you want to become the primary
Use the search screen to select a new person
Use the family screen to look through the members of the family, navigate as appropriate, then 

close.    The primary person on the family screen will become the primary on the pedigree 
screen when that screen is closed, but only if you have done some navigating or editing 
while in the family screen.    If you go into the family screen for a quick look and drop right 
back out, the pedigree screen will remain uneffected

Drop the large InfoBox, and double-click the spouse or child you want to become the primary 
individual

Use the arrows to the left of the primary person or the right of any 5th generation person as 
appropriate



Keyboard Usage on Pedigree
The pedigree screen has been designed to work with either the mouse or the keyboard.    The 
following keys work on the pedigree screen:

left arrow go back 1 generation
right arrow go forward 1 generation -- to the father if he’s there, otherwise to the mother
up arrow go to the person in the same generation who is directly above the current person.    

If the current person is the top-most person in the generation, then wrap to the 
bottom of the previous generation

down arrow go to the person in the same generation who is directly below the current person.    
If the current person is the bottom-most person in the generation, then wrap to the 
top of the next generation

Page Up as the right arrow, but go specifically to the father
Page Down as the right arrow, but go specifically to the mother
Home same as the left arrow
End same as the left arrow
Esc close the InfoBox
space bar select and deselect the curent person, thereby locking and unlocking the infobox
Enter make the current person the primary person

Additional Keyboard Usage when the large InfoBox is on screen
Tab            tab forward between the name box, the spouse box and the child box
Sh-Tab tab backward through the name box, child box and spouse box
Enter make the person with the current focus box become the primary person on the 

pedigree screen



Selected Individual
The highlighted person on the pedigree screen, or on the family screen, is the selected individual.    
As you perform various actions, they will be carried out for the selected person.
On the pedigree screen, the selected person may change as you move the mouse cursor over 
different individuals.    You can lock a selection by clicking on that person with the mouse, or hitting 
the space bar on the keyboard.    Once locked, the individual selection will not change as the mouse 
is moved across the screen.    To unlock the selection, hit the space bar again, or click the mouse 
again.



Technical Assistance
If you have a problem, here are some guidelines for resolving it:

1. If the program won’t install, please call the order line at 1 (800) 825-8864 (273-1521 in Salt Lake 
County). We’ll help you get Ancestral Quest installed, or if the disk is defective, we’ll send you a 
new one.

2. Is the problem one of not being able to do something you want to do?    If so, we’ve tried to make
both the user’s guide and this online help useful in covering both what the program will and will 
not do, and in guiding you through how to accomplish your task.
If you are new to Windows, you may be struggling with how to use the keyboard.    Please refer 
to your Windows User’s Guide, and to the keyboard topics discussed in this help file:

Windows Keys
Keyboard Synopsis

If you are not sure whether a particular task can be performed, please refer to the topical and 
alphabetical contents sections of this help file, or to the User’s Guide to read about the item you 
are looking for.    Have you tried Help’s “Search” feature?    Browse through the list of keywords to
see if you can get some clarification.

Alphabetical Contents
Topical Contents

If you’ve looked through these resources, and can’t figure out what you need, you have a few 
ways to reach someone who can help:

1. Post a message on one of the on-line services, such as CompuServe, America On-Line, 
or Prodigy, and either an Incline Software representative, or a genealogy enthusiast who 
understands what you are after will respond.
2. Call a friend who has Ancestral Quest.
3. Attend a PAF Users Group meeting.    Very likely, somebody there will be able to help you.  
(For the nearest PAF Users Group, fax us a request).
4. Send your request by fax to Incline Software at (801) 273-1535.    Give us your name, 
phone, address, a description of the request, and a good time to reach you (evenings, days),
so we can respond by mail or phone, as appropriate. If you still cannot find a solution to your 
problem, call technical support at (801) 278 5886.

3. If the program doesn’t act the way you know it should, or gives a General Protection Fault:
Try to reproduce the problem.    In other words, see if you can make it happen again, exactly the 
same way, by following the same steps.    Record the steps you took, along with the version 
number of the program, the preference settings, the number of marriages and children for the 
person you were working on when the problem occurred.    Please fax us this information at (801)
273-1535, along with the information listed in step 4 above.    We’ll give you a call if we need 
more information to solve the problem, and once it’s fixed, we’ll send you an updated copy of the
program.



File Menu
The File menu contains housekeeping options for your database.

New
Selecting New in the File menu opens a directory dialog which will allow you to select a drive and 
existing subdirectory in which to create a new family database. There is also a field in which you can 
enter a name for the database. Simply type the desired Family Name in the text field, select a 
location and drive, and click OK.
Ancestral Quest allows more than one database to be open at a time.    So if you already have a 
database open when you create a new database, the current database will become inactive, and the
new database will become the active database.

Open
Selecting Open in the File menu, or using the CTRL+O keyboard equivalent, opens a directory 
dialog which will allow you to locate and select an existing family database.
Again, since AQ allows multiple databases to be open at once, any databases already open will 
become inactive, and the newly opened database will be active.
AQ keeps track of the last 4 databases you have opened, and places their directory path at the 
bottom of the File menu.    You can open any one of them by simply selecting the desired database 
from the list.

Close
Select Close to close the currently open database. To close all databases at once, you can simply 
exit the program.

Backup
Select Backup if you would like to make a backup copy of your database. This option saves your 
database in a different format that can only be opened using the File menu’s Restore option. It is a 
good idea to back up important databases often.

Restore
Select Restore to restore a database that has been saved using the File menu’s Backup selection. 
The restore process will replace any data in a currently opened database, so use this option with 
extreme care.

Import
Selecting Import in the Data menu opens a directory dialog box allowing you to select the GEDCOM 
file that you would like to import into your database.

Export
Select Export in the Data menu if you would like to export your database as a GEDCOM file.    
Exported GEDCOM files can be Standard, Ancestral File Submission, or TempleReady GEDCOM 
files.

Print Reports
Select Print Reports in the File menu, or use the Ctrl+R keyboard alternative to open the Reports 
Selection window.
Use this window to select a report from a scrolling list of report types, and the options associated 
with it. Preview the report or send it to your printer.



Although not a report in the strict sense, the Family Reunion Contact Lists are generated from the 
Reports Selection window.

Print Setup
Selecting Print Setup opens a dialog box for selected printers. It lets you fine tune your printer 
options..

Exit
Select Exit to quit the Ancestral Quest application.



Data Menu
Use the Data menu to manipulate your records.

Add Individual
Select Add Individual in the Data menu, or use the CTRL+A keyboard equivalent to open the Add 
New Individual window.
Use this window to define specific information about a new individual, and add them to your 
database. Remember, unless you are starting a new database, the new person that you enter within 
this window will not appear on your pedigree, until he or she is linked to an individual or family 
appearing on the pedigree. 

Edit Individual
Select Edit Individual in the Data menu, or use the CTRL+I keyboard equivalent, to edit or update 
information about an individual that is already in the database.
Use this window to change existing information about the selected individual. Click the Save button 
to save the changes.

Edit Family
Select Edit Family in the Data menu, or use the CTRL+F keyboard equivalent, to open the Family 
window for the selected individual.
Use this window to define known family members for the selected individual including their mother, 
father, spouse(s), and children. Family members defined within this window will be added to your 
database.

Edit Notes Select EDIT NOTES in the DATA menu, or use the CTRL+N keyboard equivalent, to open 
either the Notes Selector screen, or the Notes editing screen, depending on how you have set your 
preferences.

Media Collection

Select MEDIA COLLECTION in the DATA menu, or use the CTRL+M keyboard equivalent, to open the 
multimedia collection for the selected individual.



Tools Menu
The Tools menu contains general utilities for working with your data.

Search
Select Search in the Tools menu, or use the CTRL+S keyboard equivalent, to open the Find 
Individual window.
Use the Find Individual window to either locate an individual by their RIN or MRIN, or browse 
through a complete list of available names.

Merge
Selecting Merge in the Tools menu opens the Merge Individuals window. You will receive a warning 
dialog before performing any merge operation. The warning suggests that you back up your 
database before you begin. Simply click OK to bypass the message, and then either continue with 
the operation, or click the Close button to close the window and back up your database.
Use this window to locate similar records within your database, and merge them into one record 
when appropriate. (You can also use this window to put any two individuals side by side for 
comparison.)

Preferences
Select Preferences in the Tools menu, or use the Ctrl+P keyboard equivalent to open the 
Preferences window. The Preferences window allows you to adjust both general options and options
specific to each database.

Database Check/Fix
If you choose the Check and Repair option, you will be asked to give the report a name and a 
directory location, and the check will begin. After the check/repair has completed, Notepad will open 
automatically to display a list of errors found, and the status of the error, i.e. (fixed).



Help Menu
The Help menu contains selections which will help you get more information about the Ancestral 
Quest application.

Contents
Choose this selection to open a standard Contents Help window and review on-line information 
about the subject of your choice.

Search
Choose this selection to open a search dialog which will allow you to search through a list of 
keywords for help about a specific subject.

About Ancestral Quest
Selecting About Ancestral Quest in the Help menu, opens the About window for the application. The 
About window contains copyright and version information about the software.
The About window also contains useful information about your database including the database 
name, it’s directory location, and the amount of disk space you currently have free.
It also lists the highest RIN and MRIN, as well as the number of previously existing records which 
have been deleted. Remember, when a RIN or MRIN is deleted, Ancestral Quest will automatically 
assign the next individual or marriage that number. Click OK to close the window.



Windows Clipboard
You can transfer information from Ancestral Quest to other Windows applications, and visa-versa.    
To do this, you must use the Windows “Clipboard”.    Don’t worry--it’s not as hard as it might sound!
For a very detailed discussion of this concept, you might want to look in your Windows User’s Guide,
but here’s the basics:

From any entry field (such as a date or place field), or the notes editing screen, highlight the text 
you want to copy.    (Again, see the Windows User’s Guide if you don’t know how to do this, or 
see the Text Selection Keys).
Use CTRL+C to copy the selected data into the clipboard (this leaves the text alone, but puts a 
copy into the clipboard), or CTRL+X to cut the selected data into the clipboard (this removes the 
text while placing it in the clipboard).    (See Editing Keys.)
Go to the place, either elsewhere in Ancestral Quest or in another windows application, place 
you cursor where you want to paste the data, and use CTRL+V to paste the data from the 
clipboard.

Using the same general concepts, you can select text in another windows application, copy or cut 
the text to the clipboard using the same keystrokes mentioned above, then paste that information 
into Ancestral Quest at an appropriate insertion point.



Ahnentafel
A numbering system for ancestry, wherein each ancestor has a pre-determined number depending 
on their relationship to the first person. Each father has a number twice as great as his child, and 
each mother has a number twice plus one of her child.



Modified Register
A Modified Register report is a special type of descendants chart. Each person receives a specific 
number that can be referred to.    The information is presented in paragraph rather than graphical 
layout.    The descendants are grouped together by generation.



Control Notes
A control note is a note that begins with a special tag. The tags currently defined as control notes 
are: TELEPHONE:, MAILADDRESS: and CONTACT_NAME. These special tags are used by 
Ancestral Quest in generating phone and address contact lists. Several reports allow you to hide 
these, as the information contained in them might be considered confidential.



Database List
As you work with databases, the database list on the bottom of the File menu will keep track of the 
four of these most recently opened.    You can use this list to gain quick access to any of these most 
recently opened databases by merely clicking on the database location you are interested in looking 
at.



Toolbar Toggle
The View menu contains two toggles.    One of these is for the Toolbar.    If this is checked, the 
Toolbar will be visible, and allow you to initiate various actions by clicking on the icons.    If the 
Toolbar toggle is not checked, the Toolbar will not be available, and more room will be available for 
the main pedigree screen.



Status Bar
The View menu contains two toggles.    One of these is for the Status Bar.    If this is checked, the 
Status Bar will be visible.    The Status Bar provides an information area, followed by the number of 
children in the currently viewed marriage in the Info Box, the number of marriages in the Info Box, 
and status information on the CAPS LOCK and NUM LOCK keys.
The number of marriages and number of children in the current marriage are only shown when the 
Info Box is in the locked state.
The information area provides different kinds of quick help, depending on what you are doing.
If the Status Bar toggle is not checked, the Status Bar will not be shown, and more room will be 
available for the main pedigree screen.



Add Individual
Select Add Individual in the Data menu, or use the CTRL+A keyboard equivalent to open the Add 
New Individual window.
Use this window to define specific information about a new individual, and add them to your 
database. Remember, unless you are starting a new database, the new person that you enter within 
this window will not appear on your pedigree, until he or she is linked to an individual or family 
appearing on the pedigree. 
Add an individual to the database simply by clicking the Add New Individual button on the toolbar, or 
selecting Add in the Data menu.

Add Individual Button

An empty Add New Individual window will open with the cursor flashing in the Surname field.
The New Individual window contains empty fields for you to add specific information about the 
individual you are adding. Begin by typing in the individual’s surname and then tab through the 
additional fields entering the appropriate information, until all of the available information has been 
entered. 
Once you have added an individual to a database, you will be able to easily attach them to other 
family members.
After you have finished entering information in the Add New Individual window, either click the Save 
button to Save the information, or Cancel to return to the pedigree.
If you would like to expand the screen to include LDS Data, select the Use LDS Data option in the 
Preferences window.

Working with Individual Data



Edit Individual
Select Edit Individual in the Data menu, or use the CTRL+I keyboard equivalent, to edit or update 
information about an individual that is already in the database.
Use this window to change existing information about the selected individual. Click the Save button 
to save the changes.

Working with Individual Data



Working with Individual Data
A single name field is limited to sixteen characters. If the name you enter is longer than 
sixteen characters, you may need to abbreviate or separate the name. This is a limitation of 
the PAF data structure, and should not be a problem in most cases.

Surname
Use this text field to enter the individual’s last name. This field should contain the individual’s 
surname, given at birth. Even if they have married, or changed their name, this field should still 
reflect the last name given the individual at birth.

Gender
Select the gender of the individual by clicking the appropriate radio button. Select “M” if the individual
is male, “F” if the individual is female, and “U” if the gender of the individual is unknown.

Given Names
There are three Given Name fields in the window. Use the fields to enter the individuals first and 
middle names. If you have fewer than three names, but one is longer than sixteen characters, use 
these fields to split the name.

Title
The Title field can be used as an additional Given Name field, or can contain titles such as Junior or 
Senior, military titles such as Lt. Colonel, or titles associated with government, such as Governor or 
Mayor. A title may also have been given to the person because of a position held within their religion,
such as Pastor or Bishop.

ID #
Use this field to enter customized identification for the individual.

Entering Information in the Dates Fields
All dates should be entered using the dd mmm yyyy format, for example, 12 Aug 1884. 
Ancestral Quest recognizes some other date formats, but if the format you use is recognized 
by Ancestral Quest, Ancestral Quest will automatically change it to the dd mmm yyyy format. 
Don’t forget to enter all four digits that represent the year. (3 digits for years between 100 and
999 AD.) AQ does not accept dates prior to 100 AD--if you have dates earlier than that, you 
will need to place them in notes, or in the Place field.

The following standard variations of the date format are also accepted:
Precede the date with the word About, or abbreviation Abt, to indicate that the date is 
approximate
Precede the date with the word Before, or abbreviation Bef, to indicate that the event happened 
sometime before the listed date
Precede the date with the word After, or abbreviation Aft, to indicate that the event happened 
sometime after the listed date
The day may be excluded to indicate an approximate date with an accurate month
Enter only the year to indicate an approximate date with an accurate year
Enter two years to indicate that the event happened within a span of years, for example, 
1845/1847
Instead of a date, you may enter See Notes, to indicate that information about this event will be 
entered in the Notes file



Birth
Use the Birth field to enter the assumed date of birth of the individual. 

Christening
Use the Christening field to enter the assumed date of christening for the individual, when 
applicable.

Death
Use the Death field to enter the assumed date of death, if applicable.
If you do not need to maintain compatibility with versions of PAF earlier than 2.31, you may enter the
following codes in the death date field: Child, Dead, Deceased, Infant, or Stillborn.

Burial
Use the Burial field to enter the assumed date of burial, when applicable, for the individual.

Entering Information in the Place Fields
The Birth, Christening, Death, and Burial fields each have an associated Place field. There are two 
ways to enter data in this field.
1. Text can be entered in a Place field by separating each name by a comma. For example, if the 

individual was born in Oakland, in the county of Alameda, in California, you would type
Oakland, Alameda, California, or
Oakland, Alameda, CA, USA
A state name in the United States is usually sufficient identification, so it is not necessary to add 
the country, unless it is outside of the United States.

2. If you would prefer, you can separate location names by positioning the cursor in the desired 
Place field and clicking the Expand Place button opening this window.
If you use this window, you should enter the city as Place 1, the county or province as Place 2, 
the state as Place 3, and the country in the final place. Any of these locations may be 
abbreviated, if desired.

Edit Options
The edit menu provides several helpful features for saving keystrokes while working with your data. 
In the upper portion of the Edit dropdown menu, you will find options for cut, copy paste, undo and 
delete. In the lower portion, you will find several ‘ditto’ options. These are divided into two primary 
types:    1) ditto from the same field of another record; 2) ditto down.
1. The F8 key allows you to ditto the information from the same field of the last record you were 

looking at. For example if you are in the edit indivual screen, marriage screen or notes and you 
selected save or cancel this record will be the record used for dittoing into the next screen you 
are in of the same type. This feature is the same as PAF’s ditto function, except that PAF has 
more limits on when this key is available.
The Shift-F8 key allows you to ditto information from the same field of the record of the father, if 
the current person has a father in the database.
The Ctrl-F8 key allows you to ditto information from the same field of the record of the mother, if 
the current person has a mother in the database.
The Alt-F8 key allows you to ditto information from the same field of the record of the next older 
sibling in the family, if the current person has an older sibling in the database.
If you have called the edit screen from the Family screen, and are working on the spouse, father 
or mother of the primary person, then the F7 key allows you to ditto information from the same 
field of the record of the primary person on the Family screen.



2. The F9 key is the ‘ditto down’ key. This operates the same as the corresponding key in PAF:    it 
copies from the first non-empty field above it of the same type. In other words, if your cursor is 
positioned in the Birth place field, there is no place field above it on the screen, so this key will 
have no effect. If your cursor is in the Burial place field, and the death and christening place 
fields are empty, but the Birth place has information, then the F9 key will copy the information 
from the birth place to the burial place. In this situation, if there is information in the death place, 
then the information will be copied from there rather than from the birth place field, since the 
death place is closer than the birth place to the burial place on the screen.

LDS Data
If you selected to use the LDS Data option, you will need to fill out the LDS section of the New 
Individual window.
Individual names are only stored once in a single database. This includes place names as 
well as the names of individuals. Regardless of the number of times you enter a name, it will 
only be stored once. However, if you separate a name into separate Place or Name fields, 
each field will be stored as a separate item in the database.
To remain compatible with PAF, however a name is entered will be the way it is displayed 
everywhere in the application. For example, if you enter the name Sykes, John for one individual, 
and JOHN, Mary for another, the capitalized version of JOHN will appear later for any display of 
Sykes, JOHN.

Notes
Media

Note:    At any time, you can cut, copy and paste information between the edit fields in this window 
and other fields, or other Windows applications. See Windows Clipboard.



Notes

Using Notes
There could be many times you may want to record some specific information about an individual. 
Notes can include interesting or special circumstances surrounding the individual’s birth, death, or 
marriage(s), humorous anecdotes that you have discovered relating to the individual’s life, stories, 
journal entries, and even quotables spoken by the individual that you have discovered.
In other words, the Notes window is a blank slate where you can enter information that is important 
to you and your family about a specific individual. However, if you would like to separate specific 
information, providing some structure to your notes file, you might consider “tagging” your notes.
For a detailed discussion of documenting sources, see Source Notes Guidelines

Creating a Generic Notes File
Within the PAF database structure, it is possible to store a notes file up to 64K in size for every 
individual. Notes are easy to enter, as the Notes window allows you to type in information much like 
you would within a word processor. No special formatting is required.
Here’s how to create a generic notes file for an individual.
1. Click the Notes button within the individual’s information window. The Notes Selector window will 

open.
2. Click OK to open the Notes window.
3. Simply begin typing. Ancestral Quest will automatically wrap your text, so it isn’t necessary to hit 

the Enter key unless you are separating the information by a paragraph. Remember, when you 
begin a new note that has a different topic, you should enter a blank line before you begin.

The Notes window will only display a limited number of characters per line, however, this
is a limitation of the PAF for DOS database. The database is capable of storing the 
information in larger chunks so that when your notes are printed they will take advantage
of the 8 1/2” x 11” page. 
Because Ancestral Quest attempts to takes advantage of this extra space, but must store
notes in 80-character lines, AQ is not always successful in putting your paragraphs back 
together the way you initially created them. Your notes may occasionally appear to be 
oddly formatted on your monitor or reports. In these cases, your attempts to adjust the 
formatting may have little effect.
If you are having trouble with formatting, try one of the following:
If AQ is attaching a line to the back of the previous line when it should not, try ending the
previous line with a period, or separate the two lines with a blank line, or indent the 
second line with one or more spaces.
If AQ is breaking a paragraph up when it shouldn’t, it is probably because you have a 
period at a place that is close to the edge of an 80-column edge. If the period is not 
needed, remove it. Otherwise, try abbreviating or re-wording some of the text in front of 
the period to get it further away from the 80-column edge.
You can also copy notes between the notes window, the clipboard, and other Windows programs. 
Editing Keys

Edit Options
The edit menu provides several helpful features for saving keystrokes while working with your data. 
In the upper portion of the Edit dropdown menu, you will find options for cut, copy paste, undo and 
delete. In the lower portion, you will find several ‘ditto’ options:



1. The F8 key allows you to ditto notes from the last record you were using.
2. The Shift-F8 key allows you to ditto notes from the record of the father, if the current person has 

a father in the database.
3. The Ctrl-F8 key allows you to ditto notes from the record of the mother, if the current person has 

a mother in the database.
4. The Alt-F8 key allows you to ditto notes from the record of the next older sibling in the family, if 

the current person has an older sibling in the database.
5. If you have called the notes screen from the Family screen, and are working on the spouse, 

father or mother of the primary person, then the F7 key allows you to ditto notes from the record 
of the primary person on the Family screen.

In any case, if you are working with ‘All’ notes, the ditto key will copy ALL notes from the record you 
are copying from. If you are working with a specific TAG, as selected from the Notes Selector 
screen, the ditto key will copy all notes with the same tag from the other record.

Tagging Notes
The Notes structure allows you to give a title, or “tag” to specific sections of your notes so that these 
sections can be easily located in subsequent sessions. In addition, tagged notes can be easily 
accessed from specific fields, such as the Birth field, within an individual’s information window. 
There are basically three kinds of notes, two of which require the creation of tags so that they can be
identified. The three basic types of notes include general notes, which typically include interesting 
anecdotes or quotables that do not relate to a specific topic, tagged notes, which usually relate to a 
specific event, such as birth, and source notes, which reference the sources of your information.

First Word Tags
The first word of a note automatically becomes a tag, but it will not appear in the Notes List unless it 
is entered using the proper format which appends a colon to the first word, “DEATH:,” for example, 
would appear in the Notes List.

Source Tags
Source notes are used to reference the location where the information in the body of the notes was 
found. Use source notes to reference the specific register or record where the information was 
found, when listing this type of source is applicable.
To tag a body of text as a source note, add an exclamation mark to the front of the word. Source 
notes tagged in this way will be printed on the Family Group Record if the source notes option is 
selected. Source note tags will also appear in the Notes List.

How to Tag
Tagging notes creates an index for your notes so that specific information, such as information about
an individuals death can be located easily. To tag information, you can either select from a default list
of categories, or create categories of your own.
Here’s how to use default tags in your note files.

If you would like to enter notes specifically regarding one of the areas listed in the Notes List, 
simply select a category and click OK. These notes are context specific and can be accessed 
from an individual’s information window.
From within an individuals information window, select a specific field, such as Death, for which 
you would like to add notes, and click the Notes button. The Notes Selector window will open 
with the selected category listed. This shortcut to context-sensitive notes is only available within 
the Birth, Christening, Death, and Burial fields of the information window.
To enter notes about the selected category, simply click OK and begin typing in the notes. To 



return to the general Notes Selector window, click the Expand List button.
Once a section of notes has been tagged, you can easily open that specific section by double-
clicking the desired tag in the Notes List. Once notes have been added for a specific tag, an asterisk 
will appear next to the tag in the Notes List. If a listed tag does not have an asterisk next to it, their 
notes have not been saved using this tag.
If you create notes using a default tag, it is not necessary to type the tag before you begin, Ancestral 
Quest will automatically add the tag to the beginning of the notes.

Creating New Tags
You can create a new tag simply by typing the topic in all caps, followed by a colon, before you begin
entering notes relating to that topic. If you create a tag in this way, it will appear in the Notes List for 
easy reference later on. 
If you would like to use a new tag temporarily, simply type the tag in the New Tag field and click the 
Add button to begin adding the notes for the new tag. The tag will appear in the Notes List as long as
the Notes Selector window is open, allowing you to easily navigate through sections of notes as they
are being entered. 
Unless a tag is created using the standard tag format, it will not reappear in the Notes List 
once the Notes Selector window has been closed. It will only appear temporarily to aid in 
easy navigation for a short period of time. Remember, if you want to add a tag permanently to
the list, you must use the standard format for tagging which includes the use of all caps, and 
the addition of a colon.

Creating/Editing Permanent Tags
You can use the ADD button to add a new ‘permanent’ tag to the list, or use the REMOVE button to 
remove one of the ‘permanent’ tags from the list. ‘Permanent’ tags are those initially provided by AQ, 
or added by you on this screen. Tags that are appended to this list, because they were found within 
the notes for the currently active individual (shown in a dimmed font color), cannot be removed from 
this list. If desired, use the DEFAULTS button to restore the tags originally supplied by AQ.

Using Telephone, Address and Contact Name Tags
Ancestral Quest has available tags for the telephone number and last known address of an 
individual. This may be very useful if you would like to keep this information for historical or practical 
purposes. 
If an individual is still alive, you may wish to stay in contact with him/her using the information 
entered in these note sections. These fields will also work in conjunction with the Print Lists’ Family 
Reunion Contact List option.
This option calls out the information saved within these sections and exports the information to a text
file. Once in a text file, the names, addresses, and phone numbers may be edited into a printable 
mailing list with any word processor. 
If you intend to produce a family contact list, you may not want the name as recorded to print on the 
list. For example, you may prefer to print the married name of a woman, or a nick-name. Also, you 
may have reasons not to contact certain relatives. You use the “CONTACT_NAME:” tag for these 
purposes. If you put “No Contact”, or just “NC” in the Contact Name tag, this individual will be kept 
from appearing on any family list. If you want a name such as “Mr. and Mrs. Robert Jones” to 
appear, you would use the Contact Name tag to do this.
To assist you in keeping data entry to a minimum, you can place the address, phone, and contact 
name information in the notes of just one spouse in a marriage. While producing contact lists, AQ 
searches first the notes of the direct descendant, if alive, for this contact information. If it is not there,
AQ will search the notes of the first spouse. Due to the possibility of separations or divorces, if the 
direct descendant has no contact name note, and the contact name of the spouse has “NC”, AQ will 



assume that only the spouse is not to be contacted. In such a case, you may need to put “No 
Contact” into the Contact Name tag note of both spouses. You may have to experiment a bit to get a 
feel for this.

Family Contact Lists
Note:    At any time, you can cut, copy and paste information between the notes edit screen and 
other fields, or other Windows applications. See Windows Clipboard.



Notes Selector
The Notes Selector screen allows you to narrow the focus of what notes you want to work on. If you 
want to see all notes for an individual, choose ‘All’. If you want to work with just the notes of a 
particular topic, say MAILADDRESS:, then select that tag from the list, and click OK. If you entered 
notes from one of the 4 main event fields (birth, christening, death or burial), only tags associated 
with that field will be initially presented to you. You can see the full list at this point by clicking the 
Expand List button. You can even add your own custom topics in the Add portion at the bottom of the
screen.

Notes
Tags



Entering Notes
You can store notes for each individual. A notes button is available in several places. You can use 
options in the Preferences screen to determine whether a notes button will take you straight into the 
notes screen, ready to view and edit all notes for an individual, or whether the button will take you to 
a “Notes Selector” window, which will allow you to choose from a selection of topics for which you 
may wish to enter notes information.



Media Collection
The MULTIMEDIA COLLECTION feature of Ancestral Quest is designed to give you a powerful tool for 
collecting important momentos, and attaching them to your family history database in ways that will 
both aid research, and provide entertainment and education for your children, grand children and 
other relatives. Ancestral Quest supports the most common forms of photos and scanned 
documents, video clips and audio clips. Each of these items is considered a media object.

Media Collection Screen
The MEDIA COLLECTION screen allows you to assemble a list of as many media objects as you would 
like for any individual in your database. You can attach photos, scanned documents, audio (voice 
and/or music) clips, and video clips. From this list, you can assemble an interactive scrapbook for 
the individual, and choreograph a slide show, including background audio – either narration or other 
sound, such as the individual’s favorite song.
The list box, in the upper left corner, allows you to scroll through all the media items you have 
attached to the individual. As you scroll through the items, each time you highlight a photo, a 
thumbnail of the photo will show in the preview box if you have checked the PREVIEW checkbox in 
the lower right corner.

Show/Play
You can use the SHOW (or PLAY) button in the upper right corner to show the photo in its full size, or 
to play video clips and sound clips. Double clicking on the item in the list will also show or play the 
item. As you scroll through the list, you will see the location of the files, and the descriptions you 
entered will be displayed in the areas below the list box.

Add
Add items to the list by using the ADD button on the bottom row of buttons. The screen you use is 
described below.

Modify
The MODIFY button allows you to make changes to the object – you can change the caption, the 
description, or even change to a different media object.

Remove
The REMOVE button will delete the highlighted item from the list of objects for the individual. The 
object itself, however, will not be deleted from the disk.

Edit Photo
Finally, the EDIT PHOTO button will take you to the Edit Photo screen, described in more detail later. 
Here, you can crop your photo, make other adjustments to its layout, and adjust the way it will be 
displayed in the scrapbook and slide show.

Make Default
Use the MAKE DEFAULT button to set the highlighted photo to be the default photo. This photo will 
show on the main pedigree and family screens when you select Photo from the quick access menu 
using the right mouse button. The default photo will also be the photo shown on reports when you 
have selected the photo option for the report.
The MAKE DEFAULT button also allows you to select a single audio selection to play as background 
for your slide show.
Default Photos and Audio clips are identified by an asterisk in the media object list. These default 
designations can be changed, by using the Make Default button (or Clear Default button, when the 



current selection is already the default).

Slide Show
You activate a slide show by pushing the SLIDE SHOW button.

Scrapbook
View the interactive scrapbook by pushing the SCRAPBOOK button.

Other Multimedia Considerations



Add/Modify Multimedia Object
You can add Photos, Audio clips, Video clips, and Photo CD pictures to your multimedia collection 
for each individual. The type of item you wish to add is selected from the drop-down list labeled ‘Item
Type.’
Ancestral Quest supports the following types:

Media Type Description Extension

Photo* BMP bmp

CALS cal

Compuserve PNG png

Encapsulated PostScript (EPS) eps

GEM Image img

Graphics Interchange Format (GIF)** gif

IBM IOCA ica

JPEG jpg, jff, jtf

LEAD cmp

Macintosh Picture pct

Mac Paint mac

Microsoft Paint msp

PCX pcx

Photo CD pcd

PhotoShop PSD psd

SUN Raster ras

Targa tga

Tagged Image File Format (TIFF)** tif

Windows Metafile wmf

WinFax fxs

WordPerfect wpg

Sound Wave wav

MIDI mid, rmi

Video Audio/Video avi

*Several of these photo formats have many sub-types. Ancestral Quest supports most, but not all, of 
these types. You will get a “Cannot Read Image File” message if AQ cannot handle the particular sub-
type of image you are trying to load. You may then need to load the image into your image processing 
software, and save it to a different file type.
** Many TIFF, and most GIF, images use LZW compression. This is a proprietary compression that is 
loosing acceptance. Ancestral Quest may not support formats that use LZW compression in future 
releases. It is recommended that you use JPEG or Compuserve’s new PNG compressed files whenever 
possible, as these are more likely to be supported in future releases.

Under Filename, type in the path/filename for the item if you know it. Otherwise, you can select the 
Browse button and search for the item. Once an item has been chosen, its path/filename will be 
displayed.
Please note:

By default, the entire path of the file will be placed in the FILENAME by the Browse screen. But if 



you are putting together a database for distribution to family members, you may want to change 
these to relative file names. For example, let’s say you have your database in a directory called 
c:\ancquest\data. You decide to put all media objects in c:\ancquest\data\scrapbk. Your aunt may
want to put her copy of the database in c:\fam_hist. So you would encourage her to put her 
media objects in c:\fam_hist\scrapbk for consistency with what you are compiling, and then you 
could refer to all objects as scrapbk\media.ext, rather than c:\ancquest\data\scrapbk\media.ext. 
AQ will look for a child directory under the current database directory for media.ext, and as a 
result, you can pass this database to relatives who want or need to use a different drive letter or 
database directory on their computer. As long as they have the same media subdirectory as you,
and you use relative paths, you will be able to send them your database and media files, and 
they will be able to enjoy the documentation and presentations you have painstakingly put 
together, using their own copy of Ancestral Quest. In order to share this data, you will need to
send a copy or backup of your database, and also a copy of all media objects. The media 
objects are not part of the database or backup – the database only stores links to the 
media objects, not the objects themselves!

You can add a Caption and Description for the item in the respective fields.
Click OK to accept your changes, or click Cancel to discard your changes. You will be returned to 
the Media Collection window.



Edit Photo
You edit the usage of the photo in the EDIT PHOTO screen, available either from the Media Collection 
screen, or by using the EDIT button on the Add/Modify Multimedia Item screen.

Crop
Above the photo, you will see its original dimensions. Using this as a guide, you may want to crop 
the photo using the edit fields in the upper left corner of the screen.

Reset
Restore the image to full size by using the RESET button.

Flip
You can also flip the photo so it will be upside down, and or flipped right to left, creating a mirror 
image by using the FLIP button.

Rotate
Rotate the image using the ROTATE button. This button will rotate the image ¼ turn clockwise for 
every time you push the button.
These adjustments to the photo are stored internally. Your photo will not be changed on disk – only 
the way it is displayed in Ancestral Quest will change.

Slide Show
Use the options in the SLIDE SHOW box to determine, first of all, whether this photo will be included in
the slide show, and if so, for how long it should be displayed. If you leave the time to 0 seconds, the 
photo will be displayed the default time selected in the Preferences screen.

Scrapbook
Use the options in the SCRAPBOOK box to determine whether the photo will be part of the scrapbook 
– both the interactive Scrapbook screen, and the Scrapbook Page report. If so, you can attach a 
sound, either a voice narrative or some other appropriate recording for playback in the Scrapbook 
screen. This sound will only be available on the Scrapbook screen. For a background audio 
on your slide show, select a default audio from the list of audio clips on the main media 
collection screen.
To accept all of your changes on this screen, click OK. To not accept these changes made, click 
Cancel.



Select Multimedia File
From this browse window, you can select the mutimedia file to be attached to this individual.
You can select the drive in the lower center of the window.
The directory to look into can be selected in the top middle window. 
The file you wish to select will be chosen from the list on the middle-left of the window. You can also 
type in the drive, path, and filename in the top left box.
The preview in the lower right corner will allow you to see grapic files before selecting them. You 
may turn off the preview by unchecking the box.



Interactive Scrapbook Screen
The Interactive SCRAPBOOK screen allows you to view six photos at a time for an individual, and 
interact with the screen using the audio buttons, if you have attached audio selections to the photos.
An audio button (looks like a speaker) is attached to each image when a sound is connected in to it 
in the Edit Photo screen. If you push the button, the attached audio will play.
The caption you entered for each photo is shown above each image, and the descriptions you 
entered are shown below them. (See Add/Modify Media Object.) You can scroll through long 
descriptions, and if you have a lot of photos, you can use the right and left arrow buttons in the lower
corners of the screen to move from page to page.



Accessing Media Collection

From the Menu bar, select Data, then Media Collection, or use the keyboard equivalent, CTRL+M to 
open the Media Collection window. The Media Collection is also accesible by clicking the Media Icon
on the toolbar--it looks like a section of film and some music.

The Media Collection screen is the gateway into the scrapbook capabilities of Ancestral Quest.

Media Collection Screen



Slide Show

Putting a Slide Show Together
You can assemble a professional quality slide show for viewing on your home computer, or for 
entertaining in a large gathering such as a family reunion, with the appropriate projection and sound 
equipment by using the tools in Ancestral Quest.
The first step is to gather the photos, and get them into your computer. You can scan them in 
yourself if you have a scanner, or you can use the services of any of a number of photo finishing and
copy services that can take your photos and put them on floppy disk or CD-ROM.
Next, use the screens described above to attach the photos to a single individual, and use the 
ORDER arrows on the Media Collection screen, if necessary, to adjust them into the right sequence.
If you intend to use a background audio, you can select one that is already properly digitized, or you 
can record it yourself. Most newer computers come with the sound boards and software needed for 
recording. You may need to pick up a microphone, then learn to use the software that came with 
your computer’s sound system.
You can use the MULTIMEDIA options of the Preferences screen to adjust the background color for the
slide show, and select a default time that each photo should be displayed. You can also choose 
whether the photos should be shown at their default scanned in size, or be adjusted to fit a uniform 
size.
With your photos scanned in and attached, and placed in the right order, and your background audio
recorded and attached, you can now select the audio as the default audio, thus making it the audio 
for the slide show. Next, run through the slide show. Perhaps you have photos or scanned 
documents that you want to keep for other purposes, but do not want to have in the slide show. Use 
the Edit Photo screen to turn off the slide show option for any such photos. Next, you may notice that
the slide show would flow better if some photos stayed on the screen for longer or shorter lengths of 
time. In this case, again use the Edit Photo screen to adjust the timing of these slides.
If some photos seem to stay on the screen longer than they should, realize that AQ has to load the 
photos off of your hardware – either disk or CD-ROM. If you have a photo that takes 3 seconds to 
load, and the slide which shows just before it is only supposed to run for 2 seconds, it will still be 3 
seconds before the latter slide will be loaded and ready to be displayed. So adjust your slide show to
take load time into account. With a few runs through the slide show, you should be able to make 
reasonable adjustments and have a polished slide show ready to go in a very short time.



Multimedia Considerations
As great as the multimedia functionality is in Ancestral Quest, there are some things you should 
know.
Prior to version 2.0 of AQ, six permanent data files were used to store information on individuals, 
marriages, events, notes, and so on. Two new files have been added to link the multimedia objects 
to the individuals in the other six files. This presents some considerations on PAF compatibility – see
the discussion later on PAF compatibility.
These two new files will not be created until you attach your first multimedia object, so if you don’t 
use these features, you can skip the rest of this section.
Most other genealogy packages cannot either deal with multimedia objects, or have not developed a
standard means of sharing this information as they can with other data through a GEDCOM file. As a
result, AQ does not currently support any way of including your multimedia information in a 
GEDCOM file for sharing with others.
The BACKUP and RESTORE functions will back up and restore the index files needed as a link 
between your individuals and the multimedia objects, but they will not back up the actual multimedia 
objects. For a complete backup, you should use AQ’s backup feature to back up your genealogy 
data and multimedia linkage files, but use another backup program – like the one that came with 
your computer operating system – to backup the multimedia objects.
If you are going to try to share your entire database, multimedia objects included, with other 
relatives, you will need to provide them with both a backup of your database (so that the multimedia 
links are there), and a copy of your multimedia files. See the discussion earlier under Add/Modify 
Multimedia Items about relative filenames to make this work smoothly.



Standardized Documentation Tags
Event Linkage Subject Research LDS Events
ADOPTION CHILD BIOGRAPHY ACTION BAPTISM
BIRTH CHILDREN CEMETERY AKA (also know as) BLESSING
BURIAL BROTHER CENSUS COMMENT (editorial) CONFIRMATION
CHRISTENING FATHER CITIZENSHIP CONFLICT DEACON
CREMATION HALF-(relative) COURT DEADEND ELDER
DEATH MOTHER EDUCATION ERROR ENDOWMENT
DIVORCE PARENTS HONORS FILE HIGH_PRIEST
EMIGRATION SIBLINGS HOSPITAL NAME (variations) MISSION
IMMIGRATION SISTER LAND NIL (nothing located) PATRIARCHAL_

BLESSING
MARRIAGE SPOUSE MEDICAL NOTE (more 

information)
PRIEST

NATURALIZATION STEP-(relative) MILITARY PLACE SEALING_PARENTS
PROBATE OBITUARY QUESTION SEALING_SPOUSE

OCCUPATION RESEARCHER SEVENTY
ORGANIZATIONS UPDATE TEACHER
RELATIONSHIP
RELIGION
RESIDENCE
TELEPHONE
MAILADDRESS
CONTACT_NAME

Note—LDS Events may also be used as appropriate to describe events in other religions. Terms like 
“CONFIRMATION” and “BAPTISM” are only included once in this table to avoid duplication. Double-
word tags such as “SEALING_PARENTS” are purposely joined by the underscore character “_” to 
indicate that it is one tag. This differs from a compound tag, which has two or more of the tags listed 
above, such as “BIRTH-MARRIAGE:”. Thus, individual tags used in compound tags are separated 
by a hyphen with the last tag ending with a colon.
Standardized Tags for use within PAF source documentation – used by permission of 
SVPAFUG – subject items below RESIDENCE added for use by Ancestral Quest



Source Notes Guidelines
Source tagged notes differ from other tagged notes in that they describe how you know the 
information – where someone else could go to find the same information. Whereas you can use any 
format you want to record the information for other tagged notes, source tagged notes should follow 
a recommended structure, that if followed, will add consistency to your record keeping, and make it 
so that others will be able to understand your notes.
Following are excerpts from the Documentation Guidelines put together by the Silicon Valley PAF 
Users Group (SVPAFUG) on recommended standards for documenting sources.

Each source contains eight elements called entry fields. These fields are used to subdivide 
information within a source. Sources are recorded in the Notes entry area for [an individual] and 
are used to substantiate specific information you have entered for the individual.
Each field contains specific details of the source, such as its title, author, or page number. Fields 
within a source appear in a specific order. The order is very significant, to facilitate subsequent 
automated processing by computers and standard appearance to human readers.
Enter information in consecutive order by Field 1 through Field 8, as shown in the subsequent 
pages. Use semicolons to separate fields. Insert semicolons for blank fields. Use commas to 
separate supporting details within a field. Use a period to end the source definition. Use a blank 
line to separate sources in your notes. Do not use embedded colons except at the end of tags.

Standardized Tag Table
Avoid using internally referenced notes. For example, creating a custom tag called “SOURCE: 
(B102)” and then referencing it within another source or notes entry causes problems for others: 
those who may not receive your private source listing; or for public databases that will likely 
inherit duplicate cross-reference numbers from unrelated individuals’ submissions. Using 
privately encrypted source information is generally an unwise documentation practice, since 
others cannot readily decode it. Instead, place private cross-references in an external file and 
use the FILE: tag.
Use semicolons accurately. Insert double semicolons to indicate missing fields: “;;”.
Use common abbreviations and omit obvious or superfluous punctuation like periods and 
commas within source notes. This saves a few characters of space in your notes and while 
typing. Be careful not to get so cryptic that you fail to clearly convey meaning. If unsure, use 
complete words, spell out place names and include punctuation.

Order and Placement When Using Multiple Tags
Field 1-8 Guidelines

This section of help used by permission of the Silicon Valley PAF Users Group, and taken from its 
publication: PAF Documentation Guidelines—1995 Edition.



Order and Placement When Using Multiple Tags
Source documentation notes, in general, should have at least one tag to describe which information 
entered into the Individual Entry screens they support. For instance, a source substantiating a birth 
should begin with the most relevant tag. In this case, BIRTH is the most significant tag and is thus 
listed first. Additional tags may be combined to convey other pertinent information. For example,

BIRTH-DEATH:
may be useful to indicate a source which describes a child living only a few hours after birth. In this 
case, BIRTH is the first and more significant tag, called the primary tag. DEATH as used above, is a
secondary tag, since it labels information which is incidental to the primary birth event.
In contrast, DEATH would be shown first if the original source was instead a death certificate or 
parish entry for deaths. For example:

DEATH-BIRTH:
correctly shows a death source citation which also contains references to birth information.



Notes Fields 1-8 Guidelines

Field 1: Source Note Identifying Character
(“!” prefix letter for all public sources)

The “!” exclamation point identifies notes that are to be considered source notes for printing on 
reports, as well as included in Ancestral File and LDS Temple submissions. Exclamation points will 
not be printed with tags on [most reports]. Omit the exclamation point if you want this note to be 
[considered a general note]. Avoid entering any sensitive or truly private information into [Ancestral 
Quest].

Field 2: TAG
(Categorize the source.)

This entry is the Event, Linkage, Subject or Research Tag (see Standardized Tag Table) that 
labels the entry for subsequent computer searching. Enter in all-capital letters and follow with a 
colon. When more than one tag applies, separate with a hyphen and end with a colon.

Field 3: Title
(Briefly describe or name the source.)

This is the name or description of the particular source record. For a book, state the author’s or 
compiler’s full name, followed by a comma, then give the title entirely in CAPITAL LETTERS. When 
referencing a periodical, place “quotes around the title” of an article.

Field 4: Years Covered
(Enter the years this source covers.)

Enter the year or entire span of years covered by this source. Separate with a hyphen, for example, 
1833-1857. Simply enter a year, like 1923, if the source covers only one event. Providing these 
dates allows you or other researchers to quickly see what time period this source covers when doing
other related research.

Field 5: Unique Source Identification
(Enter who ORIGINATED the source and reference qualifiers.)

Include any necessary combination of series, volume, part, folio, publisher information (publication 
date, publisher, city, date), item number (for microfilm) to completely and uniquely indicate who 
originated the source.

Field 6: Specific Reference
(Enter the PAGE on which to find this specific info.)

Enter the specific page number (e.g., p 123 or pp 17-19). Optionally an item number for a church 
registry or line number for a census may be entered. This field directs readers to the specific quoted 
material referred to within the source. Usually this field is unique and consequently must be entered 
each time the same source is quoted. In practice when using the same source repeatedly, you must 
enter this specific reference each time.

Field 7: General Reference
(Indicate the REPOSITORY where the source may be obtained or personally viewed.)

Enter the actual physical location or repository of this source, (e.g., Sutro Library, San Francisco 
CA). If in a library, enter the call number (e.g., book, fiche, or film). If somewhere else, enter a 
complete description indicating its location, such as “Photocopy obtained from Co Clerk in poss 
of John Smith, Salem OR.”
This field informs readers of where they may obtain copies or examine the actual source. Use 
discretion and avoid quoting addresses and phone numbers of individuals unless they’ve granted 
permission. Your sources may become a public record if submitted to Name-Matching or the 
Ancestral File. If there is no further information to be included in Field 8, end it with a period, 



followed by a blank line.

Field 8: Notes—the Main Details or Information of a Note
(End a notes entry with a period, followed by a blank line.)

The source references optionally may be continued by entering specific or summary details from this
source. When doing so, place the most significant and essential details on this individual directly in 
your note. As appropriate, include helpful research tags such as NOTE, COMMENT, QUESTION, 
ACTION, or CONFLICT, then a brief explanation or comment. Place more lengthy text (biographies, 
histories, etc.) into one or more separate documents or files, then refer to them in [Ancestral Quest] 
notes. Leave a blank line after each source entry. See the samples of notes entries below.

Using additional tags in Field 8, Notes
The Notes field may also include helpful tags. Often, information in a source is secondary in nature
—not directly related to the content of the source. For example, a birth record may contain additional
information about extended family, residence, health circumstances, hospital, etc. Secondary 
information is that which is not totally germane to the topic at hand. Often, the Notes field is useful 
for including such information. A tag is a convenient way to alert readers to this additional 
information.
When tags are used in the Notes field, they can be placed anywhere within the paragraph, not just at
its beginning. For example, the source,

!DEATH: Soc Sec Death Index; 1962-1989; FamilySearch CD ROM dtd Oct 1990, SSN 
572-09-7600;; Santa Clara CA FHC; Note: Birth date/Issuance state-Sep 1938/CA, Death 
date/state-Jul 1985/CA. CONFLICT: SSDI—Death State in conflict with other information.
Indicated as CA, actually is MI.

Shows the additional tag, CONFLICT, embedded within the Notes field and used to label a research 
problem. Embedded tags usually begin a new sentence. Multiple sentences are permitted within the 
Notes field.
In another example, a parish christening record often contains additional information such as 
witnesses, which in not directly pertinent, but which lists names potentially useful for further 
research. In this case, you may find a custom-designed tag useful:

WITNESSES: Hans Hilsen, Jens Mikelsen.
The use of Notes, Field 8, is entirely discretionary. You may include any standard or custom tag that 
might lend more clarity to your source entry.
Using “COMMENT” Instead of a “NOTE” Tag
When should you use a COMMENT tag versus the more common NOTE tag? COMMENT is used 
for editorial commentary, rather than supplemental information, for which NOTE is used.
Use NOTE to label additional information. In contrast, use COMMENT to give your opinion or 
interpretation of the source. For example:

!BIRTH-ERROR: LDS IGI;; Jun 88, VT, batch #M366042; p 261; FHL Film #1317845; 
NOTE: Given name is misspelled (Dielpha is correct).

is a note which informs of an error in entry; whereas,
!BIRTH-NIL: Birth Records; 1989-1905; Cook Co IL Registry of Births;;; COMMENT: 
Found no record of birth as expected, probably is lost.

is a comment which shows the researcher’s opinion of the possible cause of a search which found 
nothing.

Examples of Source Information Separated into Individual Data Fields 1—8

1 2 3



!BIOGRAPHY: Mary Coffin Johnson, THE HIGLEYS AND THEIR
4 5 6

ANCESTRY; 1630-1892; New York, The Grafton Press, 1892; pp 9-15;
7 8(none)

Sutro Library, San Francisco CA.

1 2 3
!DEATH-PARENTS-SPOUSE-CHILDREN: Obituary of Hans Bosen, OGDEN

4 5
STANDARD EXAMINER; 1943; microfilm dtd Sep-Nov, 1943, October issue;

6 7 8
p 108, Col 1; City Library, Ogden UT; ACTION: Get a photocopy of this document.

1 2 3 4
!MILITARY-SPOUSE: Pension application of Glen Jones; 1863-1901; Civil

5
War, IL 5th Regiment, filed by widow, Amanda Jones, 10 Sep 1901, Doc

6 7 8(none)
#198762-2a; ; Original in poss of Aaron Jones, Santa Clara CA.

This section of help used by permission of the Silicon Valley PAF Users Group, and taken from its 
publication: PAF Documentation Guidelines—1995 Edition.
For more detailed information, additional tables, and more examples of documentation guidelines, 
you may want to acquire a copy of the SVPAFUG PAF Documentation Guidelines. You can write to:
Silicon Valley PAF Users Group, 4417 Pitch Pine Court, San Jose, CA 95136.



Edit Family
Select Edit Family in the Data menu, or use the CTRL+F keyboard equivalent, to open the Family 
window for the selected individual.
Use this window to define known family members for the selected individual including their mother, 
father, spouse(s), and children. Family members defined within this window will be added to your 
database.

Adding a Family
After you have created the first individual, you can begin adding his or her family to the pedigree 
chart using the Family window.
To open the Family window, simply select Family in the Tools menu, or click the Family button in the 
Toolbar.

The Family Button

Working With a Family



Edit Marriage

Entering Marriage Information
Marriage information can be added for either the primary individual displayed within the window, or 
for that individual’s parents, listed to his or her right.

For the Individual
After a spouse has been entered for an individual, the Marriage button above the Spouse field 
becomes available. To define specific information pertaining to the marriage of the individuals listed, 
simply click the Marriage button to open the Marriage window.
Enter any information known about the marriage including the date and place where the marriage 
occurred. If the marriage ended in a divorce, click the down arrow next to the Status text field, and 
select Divorced in the drop-down combo box.
If you do not need to maintain compatibility with versions of PAF earlier than 2.31, you may enter the
following code in the marriage date field:    Not Married.

For the Parents
Marriage information may also be entered for the individual’s parents within the Family window. 
Once a mother or father have been added for an individual, the Marriage button located between the
Mother and Father fields will become accessible. 
Marriage information may be added for the parents in the same way as information is added for the 
individual as explained above.
Note:    At any time, you can cut, copy and paste information between the edit fields in this window 
and other fields, or other Windows applications.    See Windows Clipboard.

Edit Options
The edit menu provides several helpful features for saving keystrokes while working with your data.   
In the upper portion of the Edit dropdown menu, you will find options for cut, copy paste, undo and 
delete.    In the lower portion, you will find several ‘ditto’ options.    These are divided into two:
1. The F8 key allows you to ditto the information from the same field of the last record you were 

using.    This is the same as PAF’s ditto function, except that PAF has more limits on when this 
key is available.

2. The F9 key is the ‘ditto down’ key.    This operates the same as the corresponding key in PAF:    it 
copies from the first non-empty field above it of the same type.    On this screen, this is only 
useful if LDS options are enabled, and you wish to ditto the Marriage date down to the Sealing 
date.    (In fact, the Ditto Down function will only be available in this instance.)



Order Spouses
Here’s how to change the order of the spouses.
1. Select a spouse in the spouse list box.
2. Click the Order button to open the Spouse Order window. The selected spouse will remain 

selected in the Spouse Order window.
3. Click the up and down arrows to the right of the number to increase or decrease the order 

number. Once you have located the desired order number, simply click OK, or select another 
spouse and repeat the procedure.



Order Children
Here’s how to change the order of the children.
1. Select a child in the Children display window.
2. Click the Order button to open the Child Order window. The selected child will remain selected in

the Child Order window.
3. Click the up and down arrows to the right of the number to increase or decrease the order 

number. Once you have located the desired order number, simply click OK, or select another 
child and repeat the procedure.



Extra Marriages
In some cases, when you select an individual, and Ancestral Quest must make a decision between 
multiple marriages for that person, a screen will appear displaying all marriages recorded for that 
individual.    You will be allowed to select from one of these, or if adding a new parent on the family 
screen, you may cancel to indicate that the desired marriage is not on the list, and a new marriage 
must be created.



Working With a Family
Adding a Mother
To enter specific information about an individual’s mother, simply click the Add Mother button.    This 
adds a mother to the “primary” person (the person at the top left position). A new information window
will open allowing you to enter the same information about the individual’s mother that was added for
the individual. The Add Mother window is identical to the Add New Individual window, so information 
is entered in the same way, but the Search for Existing button will also be available, allowing you to 
search for an individual already in the database to be the mother for the primary individual.

Adding a Father
To enter specific information about an individual’s father, simply click the Add Father button. A new 
information window will open allowing you to enter the same information about the individual’s father 
that was added for the individual. The Add Father window is identical to the Add New Mother 
window, so information is entered in the same way.

Adding a Spouse(s)
To enter specific information about an individual’s spouse, simply select the individual and click the 
Add Spouse button. A new information window will open allowing you to enter the same information 
about the individual’s spouse that was added for the individual. The Add Spouse window is identical 
to the Add New Mother window, so information is entered in the same way.
If an individual had more than one spouse, either at the same time, or in a subsequent marriage, 
simply click the Add Spouse button and add additional spouses as necessary. To display a complete 
list of spouses within the Family window, click the down arrow to the right of the Spouse text field. If 
only one spouse has been defined, then the arrow will be gray and inaccessible.    Keyboard users 
will need to tab to the spouse down arrow and activate it by hitting the Enter or Spacebar 
keys.

Unlinking a Spouse from a Marriage
If you would like to leave an individual in the database, but unlink that individual from his or her 
spouse, you can do so within the Family window.
Simply select the desired spouse in the Spouse(s) display window and click the Unlink button. You 
will receive this confirmation dialog, simply click OK to unlink the spouse from the marriage, or 
Cancel.
Unlinking an individual from a marriage will remove the individual from the Family, but not from the 
database. 

Deleting a Marriage
If you would like to delete a marriage record from the database, simply click the correlating Marriage 
button in the Family window to open the Marriage window, and click the Delete button. 
You will receive this warning dialog. Click OK to remove the marriage from the database, or Cancel.
If you delete a marriage, the individuals involved will remain in the database, but the record of the 
marriage will be deleted, thereby dissolving the family ties between these individuals.

Adding Children
To enter specific information about an individual’s children, simply select the individual, and click the 
Add Child button. A new information window will open allowing you to enter the same information 
about the individual’s child that was added for the individual. The Add Child window is identical to the
Add New Mother window, so information is entered in the same way.
If an individual has more than one child, simply click the Add Child button to add additional children 



as necessary. A complete list of the children resulting from a specific marriage is displayed within the
Family window. 
It is important that the appropriate spouse appears in the Spouse text field before children are 
entered. When you enter a child, realize that he or she will be automatically linked to the marriage, 
represented by the primary person and spouse, when you click the Add Child button.

Ordering Children
Once you have added children to an individual in the Family window, you can list the children in the 
order that they were born. By default, children are ordered according to the order in which they were 
entered.

Order Children

Ordering Spouses
If you have more than one spouse for an individual, and would like to order them, simply click the 
Order button in the Family window, and follow the instructions for ordering children as described 
above.

Order Spouses

Unlinking a Child from a Marriage
If you would like to leave an individual in the database, but unlink that individual from his or her 
parents, you can do so within the Family window.
Simply select the desired child in the Children display window and click the Unlink button. You will 
receive this confirmation dialog, simply click OK to unlink the child from the marriage, or Cancel.
Unlinking a child from a marriage will remove the child from the Family, but not from the database.

Searching From the Family Window
If you need to locate a specific individual from within the Family window, simply click the Search 
button to open the Find Individual window. Searching from within the Family window is the same as 
searching from the main menu, except the individual you find becomes the primary individual in the 
Family window instead of the pedigree.

Deleting an Individual Record
If you would like to remove and individual from your database completely, you will do so within the 
Family window. Here’s how.
1. Locate and select the individual that you would like to remove , any name displayed in the Family

window may be selected, even spouses and children.
2. Click the Delete button. You will receive a warning dialog.
Click OK to delete the record, or Cancel. The warning dialog will also list the number of marriages 
linked to the individual you are attempting to delete. When an individual is deleted but his or her 
marriage still exists, the field containing the individual will contain the word UNKNOWN.

Editing From the Family Window
If you would like to edit the information about a specific individual within the Family window, simply 
select that individual and click the Edit button. Clicking the Edit button will open that individual’s 
information window and allow you to make any desired changes. After you have completed the 
changes, simply click the Save button to return to the Family window.

Working with Individual Data
If you want to edit the information for the marriage of either the primary couple on the screen, or the 
parents of the primary person, click the appropriate marriage button.



Working with Marriage Data
You can edit notes for the currently highlighted individual by activating the Notes button.

Notes
You can also edit and view the media collection for an individual by clicking on the Media button.

Media

Changing the Primary
If you would like an individual within the Family window to become the primary individual, simply 
select the individual and click the Primary button. Or double click any individual on the family screen 
to move him or her into the primary position.
If an individual in the father or mother position has continuing generations, then an arrow button will 
be available to navigate to the next ancestral generation. Arrows may also exist on the drop-down 
spouse list and children list to signify descendant generations. If you have navigated up an ancestral
line and you wish to navigate back though the descendants, a button will be available to the left of 
the primary individual for this purpose. A chevron («) in the child list also shows the descendant line 
which was navigated.
When the Family window is closed, the individual in the primary position will become the primary 
individual on your pedigree chart as well. 



Reports
Now that you have the desired information in your database, you will be able to print helpful reports 
of your information to share with family members and ancestral organizations. Ancestral Quest 
allows you to customize your reports to suit your specific needs. This chapter helps you understand 
the different options associated with report printing, and walks you through the printing process.

Select Print Reports in the File menu, or use the Ctrl+R keyboard alternative to open the Reports
Selection window.
Use this window to select a report type, and the options associated with it, preview a report, and 
send it to your printer.

Opening the Reports Window
There are three ways to open the Reports window so that you can begin selecting specific report 
options.

Select Print Reports in the File menu
Use the CTRL+R keyboard equivalent
Click the Print Reports button in the Toolbar

Once you have opened the Reports window you can easily select a report type by scrolling through 
the options in the Report Type window. The icon associated with the report provides you with a 
visual representation of the report. Every report type has additional options associated with it which 
will appear when the report is selected. Descriptions of all the available reports and their associated 
options follow.
When you are ready to print your report, simply click the Print button in the Reports window. A Print 
Options window will open allowing you to define specific print range and quality, as well as the 
number of copies you would like to print. You can also access the Print Setup window by clicking the 
Setup button. When you have finished your selections, simply click OK. 

Pedigree Chart
Family Group Records
Ancestry Chart
Descendants Chart
Individual Summary
Lists
Books
Preview
Printing



Print Setup
Selecting Print Setup opens a dialog box for selected printers. It lets you select paper size and 
orientation, and gives you control of several printer effects. For a complete description of the Print 
Setup options, refer to your Windows system or printer documentation.



Pedigree Chart
A Pedigree Report prints specific database information in much the same way as it appears within 
the application’s pedigree screen. You can print between four and six generations on a single page. 
The report also includes information such as recorded birth and death dates and places, and 
marriage information when applicable. 
Birth, death, and marriage information is printed, when available, for every person on the report. A 
spouse, when available, is added for the starting individual on the report.

Chart Type
Use the Chart Type section to specify the printing of a single, cascading, or blank form. Select by 
clicking the appropriate radio button.

Single
This option prints a one page chart listing up to six generations.

Cascading
This option prints a specified number of generations with up to six generations appearing on 
each page. This option will print several pages, depending on the number of generations you 
have specified. Each page will be numbered so that you will be able to keep them in order, or 
attach them if necessary.

Blank form
Select this option to print a blank pedigree report on a single page. This form will always contain 
4 generations, and can be filled out by hand or by typewriter.

Index Options
Use the Index Options section to specify whether or not you want to print an index with your 
pedigree report. An index is an alphabetical listing of individuals within the pedigree, their RIN 
number, their birth and christening dates, death and burial dates, and their position and chart 
number on the printed pedigree.

No Index
This option will print the pedigree chart without an index.

Include Index
This option prints an index as well as the pedigree chart.

Index Only
This option prints an index, but not a pedigree chart. Its purpose is to allow you to generate an 
index to go with an exising chart, without having to reprint the chart itself. In order for this to work
properly, all general options must be the same as they were when you generated the chart that 
this index is to accompany. If you don’t get the options right, the index won’t reflect the 
information on the existing pedigree charts accurately.

General Options
The bottom portion of the window is used to define specifics about your report. Some of these 
options are available only when certain chart type and index options are selected.

Starting Person
The starting person, who will become the primary individual on the printed report, will, by default,
be the currently highlighted individual in the pedigree screen. If you would like to select an 



alternate starting person, click the Search button and locate the other person. The starting 
person’s name will appear in the window.

Generations per page
Use the arrows to the right of this field to select four, five, or six. The number you select will 
determine the number of generations appearing on each page of your report.

Chart number of this Chart
If you would like to select a number, other than one, as the chart number, simply type the desired
number in this field.

Starting person is same as person/on chart number
Use these two fields to specify that the starting person be the same as a specific individual on 
another chart.

Starting # of continuation charts
This option is only available if you are printing cascading charts. Use this field to specify the 
starting number for subsequent charts in a cascade.

Number of generations to print
This option is only available if you are printing cascading charts. Use this field to specify the 
number of generations you would like to print. This field will accept any number of generations, 
up to 199.

Include Photos
Choose this option to allow photos to print on your report. Then click on the Photos button to 
select the photo options for the report.

Suppress RINs/MRINs
Even if you prefer to see RINs or IDs appended to the names on your screens, you may not want
them printed. You can suppress all RINs and MRINs using these options.

LDS Ordinance Information
If you have the LDS Data Options turned on, you will see additional information relating to completed
ordinance work on the charts, otherwise this information will be missing.

Page Setup



Family Group Sheet
A Group Sheet prints specific database information in the form of a report. This report contains much
more specific information about individuals than the Pedigree Report. You even have the option of 
printing notes in this format. The report also includes basic information such as recorded birth and 
death dates and places, and marriage information when applicable.

Sheet Options
Use the Sheet Options section to specify the printing of a single, cascading, or blank report. Select 
by clicking the appropriate radio button.

Single Family
This option prints the chart for one family listing an individual’s immediate family only.

Cascading
This option prints a specified number of generations up to 199. This option will print several 
pages, depending on the number of generations you have specified. Use the Number of 
Generations field to enter the desired number of generations. Next to the Number of 
Generations is a set of radio buttons, which allow you to determine whether to cascade up (in an
ancestral direction), or down (in a descendant direction).

Blank form
Select this option to print a blank group sheet on up to three pages. This form may then be filled 
out by hand. The blank form will always print an expanded layout form.

Expanded
The expanded layout allows 4 children on the first page, with 6 on additional sheets. If you 
include submitter information, the first page will allow for only 3 children, and place the submitter 
information in the remaining space.

Medium
The medium layout allows 6 children on the first page, with 8 on additional sheets. If you include 
submitter information, the first page will allow for only 5 children, and place the submitter 
information in the remaining space.

Condensed
The condensed layout allows 8 children on the first page, with 10 on additional sheets. If you 
include submitter information, the first page will allow for only 7 children, and place the submitter 
information in the remaining space.

Notes Options
Use this section to specify which type of notes, if any, you would like to print with the group sheet.

Source Notes
Selecting this option will print notes that have been tagged as “source” notes (those notes 
beginning with an exclamation mark “!”).

General Notes
Selecting this option will print all available notes for the individuals listed on the group sheet 
except for source notes.
If neither Source Notes nor General Notes is chosen, your printout will not include any notes. If 
both of these options are chosen, your printout will contain all notes for each individual.



Hide Ctrl Notes
If General Notes is selected, you will be allowed to hide control notes.

Other Marriages
Select this checkbox if you would like marriages other than the listed marriage to be noted on the
group sheet in the notes section.

Parents Only
To print notes only for the parents, check this box. If you are producing a cascading set of charts,
the children’s notes will be printed on their own family’s form, thus eliminating duplication of 
notes between family sheets.

Notes on 1st Page
Normally, if the family you are printing is small, you will get the family on the first page of the 
report, and any documentation will start on the next page. With a larger family that won’t all fit on 
the first page, documentation always starts immediately after the last child.
Select this checkbox if you want documentation to start immediately following the last child when
the family doesn’t fill the first page.

Other Options

Mark Direct Line
Selecting the Mark Direct Line box will cause an ‘X’ to appear by each child in cascading FGRs 
who are the direct ancestors of the starting person in the cascade.

Include Photos
Choose this option to allow photos to print on your report. Then click on the Photos button to 
select the photo options for the report.

Suppress RINs/MRINs
Even if you prefer to see RINs or IDs appended to the names on your screens, you may not want
them printed. You can suppress all RINs and MRINs using these options.

Selected Family Member
Use this section of the window to select the marriage that you would like to use to begin the group 
sheet. By default, the marriage associated the selected individual on the pedigree will be selected. 
Click the Search button to select another marriage. Select either the Parent or Child radio button to 
classify the listed individual as parent, thereby listing his or her children, or child, thereby listing the 
family of his or her parents.

If the LDS Data option is turned on, additional LDS ordinance information will be printed in this 
report.
Use the Shade Reports option of the Preferences screen to turn on or off the shading in some 
header areas of this report.

Font Selection
Page Setup



Ancestry Chart
The Ancestry chart comes in two layouts:    a Standard Chart and a Wall Chart. Some options are the
same for these two reports, but each also has its own unique options.
This chart is similar to the pedigree chart. While the Wall Chart can supply varying degrees of 
additional information with each each person and can span several pages wide and several pages 
down, the Standard Chart provides only date information on birth and death for each person and will 
fill only a single page width for as many pages down as needed. These charts place individuals in an
ancestral pedigree, beginning with the starting person and tracing back through his or her ancestors.
The Ancestry Chart will allow you to print to larger page sizes – up to 320” by 320” using appropriate 
plotters or large paper printers that have Windows drivers. Most users will not have direct access to 
such large printers, but may find that a local engineering or architectural firm may rent use of their 
equipment. You can print these reports to a file, using the driver for the plotter or printer, then you 
can take the file to the location of the large paper printer and copy the file to the printer.

Starting Person
By default, the ancestry report will begin with the selected individual on the pedigree, but you can 
select any other individual in the database to begin the chart. Simply click the Search button to 
locate the individual, and his or her name will appear in the window.

General Options
General options include the number of generations which you would like to print (which may be any 
number up to 199), and the option to suppress RINs.

Suppress RINs
Even if you prefer to see RINsor IDs appended to the names on your screens, you may not want 
them printed. You can suppress the printing of RINs using this option.

Chart Options
The Chart Options section allows you to choose which type of Ancestry chart you want: Standard or 
Wall. Choose from the two radio buttons to print a Standard Chart or a Wall Chart. With this option 
chosen, the rest of the screen shows the unique options available for that chart type.

Standard Chart
Wall Chart

Use the Shade Reports option of the Preferences screen to turn on or off the shading on the names 
of this report. Shading will affect the standard chart, and the wall chart when no other information but
name is selected for each person.

Font Selection
Page Setup



Descendancy Chart
This chart presents information on a person and the person’s descendants in a graphical format. You
can print either a Standard Descendants chart, which prints one page wide for as many pages as 
needed (showing only one name and some dates per line), or you can print a Descendants Wall 
Chart, which allows you to span as many pages across, and as many pages down as needed, with 
name, photo, notes, and event information for each person.
Descendant Wall Charts can get to be especially narrow and long. By using a manual technique 
presented here, you can change a Descendant Wall Chart from filling the side of the Empire State 
Building to fill instead the Great Wall of China. Let’s say that a descendant chart of your great-great-
grandmother will be extremely long. And let’s say that she had eight children. If you will print just one
generation of descendants for her, you will get a header and information for her and each of her 
spouses. Then print a descendant chart for each of her children, including all generations down to 
the present. By assembling these individual wall charts for the children side by side, then covering 
the individual titles with the information printed for great-great-grandmother, you can end up with a 
wider and less tall report. You might have to draw in a few connecting lines with a straight-edge.
The Descendants Chart will allow you to print to larger page sizes – up to 320” by 320” using 
appropriate plotters or large paper printers that have Windows drivers. Most users will not have 
direct access to such large printers, but may find that a local engineering or architectural firm may 
rent use of their equipment. You can print these reports to a file, using the driver for the plotter or 
printer, then you can take the file to the location of the large paper printer and copy the file to the 
printer.

Starting Person
By default, the descendants report will begin with the selected individual on the pedigree, but you 
can select any other individual in the database to begin the chart. Simply click the Search button to 
locate the individual, and his or her name will appear in the window.

General Options
General options include the number of generations which you would like to print (which may be any 
number up to 199), and the option to suppress RINs.

Suppress RINs
Even if you prefer to see RINsor IDs appended to the names on your screens, you may not want 
them printed. You can suppress the printing of RINs using this option.

Chart Options
The Chart Options section allows you to choose which type of Descendants chart you want: 
Standard or Wall. Choose from the two radio buttons to print a Standard Chart or a Wall Chart. With 
this option chosen, the rest of the screen shows the unique options available for that chart type.

Standard Chart
Wall Chart

Use the Shade Reports option of the Preferences screen to turn on or off the shading on the names 
of this report. Shading will affect the standard chart, and the wall chart when no other information but
name is selected for each person.

Font Selection
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Individual Summary
Use the Individual report options to print a summary of the information available for a specific 
individual.
If the LDS Data option is turned on, additional LDS ordinance information will be printed in this report

Starting Person
Make sure that the person you would like to appear in the report appears in this section. If you would
like to locate a new individual, simply click the Search button.

Including Notes
Select this option if you would like to include the notes associated with the individual as part of the 
report.

Hide Ctrl Notes
If Notes is selected, you will be allowed to hide control notes.

Suppress RINs and Suppress MRINs
You may suppress the appended RIN or custom ID from printing with the names by checking the 
Suppress RINs checkbox. Similarly, by checking Suppress MRINs, you will prevent the MRIN from 
primting, as well.

Include Photo
By checking the Include Photo option, the report will include a photo for each individual there is a 
photo available. To have the report ‘reserve space’ for a missing photo, click the Photos... button and
set that, and other photo preferences. The Photos... button is only available when the Include 
Photos item is checked.

Font Selection
Page Setup



Lists
The List window allows you to select and print one of several lists that may provide helpful 
information to you.

Unlinked Individuals
Duplicates
Individuals by RIN
Individuals by Alpha
Possible Problems
Family Reunion Contacts
Incomplete Individual Ordinances
Incomplete Marriage Sealings



Unlinked Individuals Report
Select this option to print a complete list of individuals in your database who are not linked to a 
family or spouse.
Use the Shade Reports option of the Preferences screen to turn on or off the shading that is 
available to enhance this report.



Duplicates List
Select this option to print a complete list of individual records which appear to be duplicated. When 
this option is selected the Options button will become available. Click the Options button to open the 
Duplicate Individuals Report Options window. 
Use this window to select which criteria you would like to consider when determining the validity of 
duplicate records.
Use the Shade Reports option of the Preferences screen to turn on or off the shading that is 
available to enhance this report.



Family Reunion Contact List
This list is a special feature offered only by Ancestral Quest. It is not printed, it can only be exported 
in a text format where it can be opened by any word processor. It is a unique way to easily prepare a
list of individuals to contact for specific mailing or contact purposes, such as a family reunion, and it 
is compiled straight from your database! 
Before you export the list, you should be aware of some special considerations.

The starting person should be the common ancestor in whose honor the reunion will be held. By 
default, the starting person will be the selected individual. If you would like to select another 
individual, click the Search button and locate a new person.
By default, only the individuals that you have entered notes for, and tagged those notes as 
MAILADDRESS: and/or TELEPHONE:, will be included on the list. However, in the options 
screen, you can specify that any living person born prior to a specified year will appear in the list.
Only living descendents will be included on the list.
This list will normally include the names of relatives as stored in the database. There are times 
that you may want to over-ride the birth names for purposes of making contact. Use the 
CONTACT_NAME: tag in notes for this.

Remember, if you enter an address for children still living at home, you will get multiple 
entries on your list for the same address. Because this may increase your mailing costs, or 
require a manual review, you likely will not wish to include this information in an individual’s 
notes until they have moved away from home.
When you select the Family Reunion List option, the Options button will become accessible. Click 
the Options button to open the Family Reunion List Options window.
The Print button will change to an OK button when the Family Reunion Contacts option is selected, 
and the Preview button will not be available. When you are ready to export the list, simply click OK. A
directory dialog will open allowing you to give the list a file name and select a directory. When you 
decide on a name and a directory, click OK and the export will begin immediately. When the process 
is completed, Window’s Notepad application will be invoked to show you the list you have generated.
You will want to close Notepad when you are finished looking at the output.

Options
Text File



Contact List Options
Use this window to select either a phone list, or an address list by clicking the appropriate radio 
button. If you would like to include descendants on the list for whom you do not have name and 
address notes, simply click that checkbox. You can limit the list to descendants born prior to a given 
year, to eliminate young children from the list. Individuals for whom you have no birth or christening 
dates will not appear on this list unless they have TELEPHONE: or MAILADDRESS: notes.



Contact List File Selection
Select the drive and directory where you want the Family Reunion Contact list to be saved. Then 
enter a file name. This file can later be opened in a word processor or be printed.



Missing Individual Ordinances
This report option is only available when the LDS Data option is selected. It provides an alphabetic 
list of every individual that is missing at least one ordinance. All available ordinance information will 
be displayed so that determining the missing ordinance(s) will be easy.
Use the Shade Reports option of the Preferences screen to turn on or off the shading that is 
available to enhance this report.



Missing Marriage Sealings
This report option is only available when the LDS Data option is selected. It provides an MRIN sorted
list of marriages that do not have a recorded sealing date.
Use the Shade Reports option of the Preferences screen to turn on or off the shading that is 
available to enhance this report.



Previewing
If you would like to preview any of the reports before you print them, simply click the Preview button 
in the Reports window to open a visual recreation of the report. You can zoom in and out to view the 
entire report or a specific portion of the report in detail, change the display from one page to two, 
scroll through several pages, and even print the report directly from this screen. This is an excellent 
way to view lists and reports, without actually printing them.



Individuals by RIN
This is a sorted list. You can select a range of RINs to be printed.

Options
Use the Shade Reports option of the Preferences screen to turn on or off the shading that is 
available to enhance this report.



Individuals by Alpha
This is a sorted list. You can select a range of individuals by selecting a starting and ending name to 
be printed.

Options
Use the Shade Reports option of the Preferences screen to turn on or off the shading that is 
available to enhance this report.



Individuals by RIN Options
When this screen opens, it will present the first and last valid RIN numbers in your database. Enter 
the starting RIN for the report, followed by the ending RIN, or leave the defaults to get a full list of 
individuals sorted by RIN.



Individuals by Alpha Options
When this screen opens, it will present an empty start name field, indicating that the report will start 
with no last names, and a ‘Z’ in the end name field, indicating that the report will end with names at 
the end of the alphabet. These start and end name fields can be overwritten with any partial names 
you want, up to 8 characters in length. You can thereby indicate a range of individuals you want on 
your report.
For example, if you want all of the names beginning with ‘M’, enter an ‘M’ in both the start and end 
name fields. If you want roughly all the ‘Jones’ through ‘Smith’, enter something like ‘JON’ in the start
name field, and ‘SMI’ in the end name field: you will get all names that begin with ‘JON’ through all 
names that begin with ‘SMI’.



Books
You can print information from your database into either of two book summary forms:    an Ahnentafel
report, or a Modified Register report. Both forms print birth, christening, marriage, death and burial 
data in narrative form. You can choose to include notes and an index. The output from these reports 
is similar to that published in many professionally done family publications.
Both of these reports allow you an option of printing to file. This allows you to apply your own fonts 
and styles, and to otherwise adjust the layout and information prior to printing. You can even use 
your word processor to attach photos to your final output. Since the information in the Ahnentafel 
Chart is similar to that in the Pedigree and Ancestry charts, and the information in the Modified 
Register is similar to that of the Family Group Record, and the Descendants chart, you can use 
these reports to get your family information into a file, from which you can generate your own 
reports.



Ahnentafel Chart
An Ahnentafel report starts with a specified person, and lists his ancestors. Each person is 
numbered. The first person is number 1. The number of each father is calculated by multiplying 2 
times the number of his child. The mother’s number is 2 times the child’s number plus 1. For 
example, the father of number 16 would be number 32, and his mother would be number 33. He 
(number 16) would be the great-great-grandfather of number 1.

Book Options



Modified Register Report
The Modified Register report lists all the descendants of a person. The starting person is number 1. 
Beginning with the first child of number 1, descendants are numbered sequentially as they are 
encountered.

Book Options



Common Options for Books

Notes Options
You will be given the option of determining which notes you want on the report, and where the notes 
will be presented.

Source/General Notes
Select any combination of source tagged notes and general notes to be printed.

Hide Ctrl Notes
If General Notes is selected, you will be allowed to hide control notes.

Embed Notes
If either Source Notes or General Notes are selected, you will be given the option of embedding 
notes in the report with the person they belong to. If this option is left unchecked, all notes will be
placed together at the end of the report in an appendix.

Other Options
Several other options allow you to fine-tune the layout of these books.

Index
If you choose the Index option, an alphabetized list of all people on the report will be generated 
as an index to, and will appear at the end of the report.

Include Photos
Choose this option to allow photos to print on your report. Then click on the Photos button to 
select the photo options for the report.

Each Generation on New Page
Checking this option will cause a page break between generations.

Suppress RINs/MRINs
Even if you prefer to see RINs or IDs appended to the names on your screens, you may not want
them printed. You can suppress all RINs and MRINs using these options.

Max Generations to Print
Enter the number of generations you want presented. If you don’t have enough data to fill all the 
generations, the report will stop before it reaches this maximum number.

Repeating Individuals Options
There are situations in everyone’s family, wherein relatives inter-marry. In producing an ancestral or 
descendants type chart, some lines will repeat. The Pedigree and Ancestry charts eliminate these 
duplicate lines by printing a note each time a duplicate ancestor is encountered, and then not 
continuing the line. The Descendants chart also eliminates duplicate descentant lines in the same 
way.

Eliminate
This option will cause the duplicate ancestor and descendant lines to be eliminated from the 
report, after an appropriate reference to the single line that has been fully explored.

Abbreviated Reference



This option will cause all duplicate lines to be printed, but each time a duplicate individual is 
encountered, only a reference back to the first occurrence of this person will be generated, not 
the full information on the individual.

Full Reference
This option ignores the duplicates situation, and prints all information on all individuals 
encountered, regardless of how many times a single individual may appear.

Printing to File
Both of these books can be printed to file. To do this, you select the Print button rather than the 
Preview button. You will be asked whether you want to print to File rather than to the printer. If you 
select ‘No’, the output will be generated to the printer. If you select ‘Yes’, you will be given the 
opportunity of selecting a file name to send the output to. Once the information has been sent to file, 
you can access this file in any word-processor and adjust fonts, margins, layout, etc. You can even 
import photos (if you have a good word-processor) into this document for your book.

Font Selection
Page Setup



Possible Problems
This list allows you to discover any data problems, such as a death date prior to a birth date, or a 
birth date after parents were too old or had died. An options screen is available to select a sort order 
of RIN or Alpha, a range of records to print, and parameters to define ranges for specific problems. If
LDS Data options are selected you can also choose whether or not you want discrepancies in the 
LDS ordinance information to be presented.



Possible Problems Options

Sort Option
Select RIN to sort by the internal record ID number or Alphabetic to sort alphabetically.

Range
If RIN sort is selected, you will be presented with the first and last valid RIN numbers in your 
database. Enter the starting RIN for the report, followed by the ending RIN, or leave the defaults to 
get the list of individuals sorted by RIN.

If Alphabetic sort is selected, you will be presented with an empty start name field, indicating that the
report will start with no last names, and a ‘Z’ in the end name field, indicating that the report will end 
with names at the end of the alphabet. These start and end name fields can be overwritten with any 
partial names you want, up to 8 characters in length. You can thereby indicate a range of individuals 
you want on your report.
For example, if you want to check all the names beginning with ‘M’, enter an ‘M’ in both the start and 
end name fields. If you want roughly all the ‘Jones’ through ‘Smith’, enter something like ‘JON’ in the 
start name field, and ‘SMI’ in the end name field: all names that begin with ‘JON’ through all names 
that begin with ‘SMI’ will be checked for possible problems.

Mother’s age should be between...
Use this option to enter the valid range allowed for a mother at the time of childbirth.
For example, if you have chosen 16 and 45 as a valid range, and a mother in your database is 
recorded as being 15 years old or younger, this would show on the report as a possible problem. 
Likewise if a mother is recorded as being 46 years old or older at the time of childbirth this would 
also show as a possible problem.

Father’s age should be between...
Use this option to enter the valid range allowed for a father at the time of childbirth.
(See above example)

Age difference of husband and wife
This option allows you to enter the maximum number of years between a husband and wife that will 
not be presented as a possible problem. If a husband and wife are farther apart in years than the 
option seleteced, then this will be reported.

Check LDS Data
Choose this option if you wish to find possible problems with LDS data.

Check Marriage and Children order
Choose this option if you wish to compare the order of marriages with the actual dates of the 
marriages. This will also check the order of the children compared to their respective birth dates. If 
either the marriages or children are out of date order then this will be reported.



Fonts for Report
You have some flexibility with Fonts on your reports.
In the drop-down box in the top left of this window is a list of the items for which you change the font.
The currently active font for the selected item is listed below.
To use a different a font, first select the report item, then click the ‘Change’ button. The Windows’ 
font selection box will pop up and you can choose your desired font.
To reset the report to the AQ default fonts, click ‘Set to Defaults.’

Click OK to accept your changes. Click Cancel to discard them.



Font Selection
Type or select a font name from the fonts listed as being installed in your system.
The default type style for a given font is usually ‘regular.’ You may also be able to utilize the styles 
available for the selected font, like bold or italic.
Type or select a size. Your printer and the selected font determine the sizes available. If the size you 
type is not available on the current printer, the closest available size will be applied.
A sample of your seleted Font will be displayed.



RIN List
You can create a list of RINs for which you would like this report printed.
Your list is typed in the the entry box using numeric keys.
Each RIN must be separated by a comma, but you do not need spaces.

Example:    6,21,25,4576
You can also specify a range of RINS using a hyphen.

Example:    235-240 (to print RINs 235, 236, 237, 238, 239, and 240.)
You can use any combination of the two, as long as they are separated by commas.

Example:    6,21,25,235-240,4576

If you are not certain of the RINs you wish to print, you may click on Browse to search your 
database. Once you have selected a RIN and are back on this RIN list window, you can type in a 
comma, then Browse again. This process can be repeated as necessary until your RIN list is 
complete. Again, each RIN must be separated by a comma.
Click OK to accept your list. Click Cancel to discard it.



Page Setup
The Page Setup window is similar to most print windows. You can select the printer you wish to use, 
as well as paper size, source, and orientation.
Ancestral Quest will also allow for some margin adjustments, based on your printer capabilities and 
the report being printed.
To utilize a different printer, or paper size or source, use the drop-down lists to select your desired 
setting.
Click Portrait or Landscape to select the paper orientation.
Margins can be individually adjusted for Left, Right, Top and Bottom. The tab key will move the 
selection to each setting in that order. Tabs can be set in increments of tenths of inches.
The Options button will bring up the window for the selected printer’s customization options.
The network button allows you to select from your network printers, if applicable.
Click OK to accept these settings. Click Cancel to discard these settings.



Photo Options
You can select some options for printing Photos in your report.
A maximum size may be set for all photos. The report, however may have to adjust these settings to 
make the photos fit into the allocated space. The photo size can be adjusted by thousandths of an 
inch.
Depending on the report, you may be able to adjust where the photo is placed in relationship to the 
adjacent text. Available options will be indicated by dark text with a white radio button dot. Click the 
text or radio button for the position you wish the picture to be placed. Again, dimmed options will vary
depending on the report being printed.
You can reserve the space for a photo on people that do not have one. This is nice if you want to 
have a uniform look to your report, or if you wish to physically paste in photos after the report is 
printed. By default, this option is turned on. You can turn it off by unchecking ’Reserve Space.’
Click OK to accept your changes. Click Cancel to discard them.



Scrapbook Report Options
The Scrapbook report is a collection of photographs printed to paper. Each photo can be 
accompanied by its caption and description.

Starting Person
The starting person, who will become the primary individual on the printed report, will, by default, be 
the currently highlighted individual in the pedigree screen. If you would like to select an alternate 
starting person, click the Search button and locate the other person. The starting person’s name will 
appear in the window.
Alternately, you can print Scrapbooks for a list of people by RIN. Select this option by checking ‘Use 
List,’ then click on ‘Edit List’ to compose your list of RINs to print.
The following options may be turned on or off by checking/unchecking their associated box.

Include Caption:
This option is on by default and will display the photo’s caption in the report. You may also choose 
it’s postion, either above or below the photo, using the radio buttons.

Include Filename:
Selecting this option will display the picture’s filename. It will be placed between the photo and the 
description.

Include Description:
This option prints the photo’s description beneath the picture. This is on by default.

Print Boxes:
Each photo can have a decorative box around it. The default is a single line box with sqare corners. 
You can change the box type by clicking ‘Box Styles.’ The boxes may be turned off completely by 
unchecking the ‘Print Boxes’ option.

Items per Page:
Type in or use the arrow buttons to select the number of items to be displayed Across and Down the 
page. The more items you print on a page, the smaller each will be. For example, if you have chosen
a standard 8 ½” x 11” page, in landscape mode, with ½” margins on all sides, you have a printable 
area of 7 ½” high by 10” wide. If you have chosen two items down, and three items across the page, 
each scrapbook item will have a size of roughly 3 ½” wide by 3” tall after leaving some room for gaps
between items.

Use Photo Size
Finally, the USE PHOTO SIZE options are available to fine tune picture usage in the scrapbook. The 
displayed size is the size you selected on the Photo Options screen, and if you want to adjust the 
size, use the PHOTO button to access that screen. The size of the area allowed for each photo 
and its accompanying information is not determined by this size, but rather by the page size, 
margins, and number of items across and down the page. See Items per Page above.
If you choose EXACT SIZE, then AQ will size the photo to exactly the size you have requested. If you 
haven’t given it enough room, the photo will be scaled down even further. AQ will try to provide at 
least one line each for your caption, filename, and description, if these have been requested, and 
then print the photo if there is still room. If you choose MINIMUM SIZE, AQ will not only try to print the 
photo to the size requested, but will treat the size as a minimum. If you have provided enough room, 
the photo will be enlarged if possible.

Font Selection



Page Setup
Photos



Wall Chart Box Style
Each individual on the wall chart can have a decorative outline box around it. Select ‘Print Box’ to 
activate this option that is off by default. The default box style is a single line with square corners. 
The box style can be changed by clicking the ‘Box Styles’ button.

Corner Style:
Click the appropriate radio button for the corner style you wish to use. The preview window will 
display a sample for each style as it is selected to assist you in your choice of square, round or 
inverted round.

Line Style:
You also have a choice of three line styles: Single, Thick, and Double. These options are selected by
clicking the appropriate radio button, and a sample of each style will be displayed in the preview 
window.

Shade Box
Choose this option to put a light gray shading as background throughout the interior of the box.

Shadow
Choose this option to cause a narrow shadow to appear to the lower right sides of the box, giving a 
3-D appearance to your report.
Click OK to accept your changes. Click Cancel to discard them.



Wall Chart Items
Wall Charts offer great flexibility in the items to be displayed. In fact, the options may almost be 
overwhelming. Utilizing the Preview button, though, you can get a good feel for how the information 
can be presented in conjunction with the photos and other page options. To choose the items you 
wish to include in the report, click the ‘Select Items’ button from the Wall Chart options section.

Name Line
Following each name, you can choose the basic event years to be displayed. By default, the name 
will be followed by the Birth, Marriage, and Death years. Each can be turned off by unchecking the 
approporiate box. The sample line will display how the line will look with the selected date options.

Events:
The Events option can be very confusing, so we will explain this carefully. You will notice the Events 
section is in two parts. The top half lists the events that can be displayed. You can choose almost 
any combination of the listed events. Each event will be listed as a Date and/or Place. Under the 
seperator line, you have three options for placement of those events.

Event Items:
Notice that Birth has a selection box. Christening also has a selection box. Selecting Birth will 
activate the date/place for the birth. You can additionally activate the christening item. These will be 
treated as two separate events and space will be reserved for each. You can select one or the other 
or both. The option, “Birth or Christening” works this way:
If there is a birth date for the individual, it will be printed and ignore the christening information. If 
there is no birth data for the person, it will instead display the christening info. If you select the ‘Birth 
or Christening’ option, the standard ‘Birth’ and ‘Christening’ boxes above are disabled.
The same conditions apply to the Death and Burial items. Select death to display the Death 
date/place. Slelect Burial to reserve space and display the Burial date/place. Or, select the ‘Death or 
Burial’ item to display only one of the two events: Death, OR if that data is not available, then Burial.
The marriage item allows you to display the marriage date/place.

Event placement:
For each event previously discussed, the report will display the event’s date and/or place. In this 
placement section, you choose how they will be displayed.
Select ‘Date on it’s own line’ to display the date only on ia separate line. ‘Place on its own line’ will 
display the Place by itself on a line. You may use either or both of these options. Choosing both 
would display birth items like this:
B: 16 Jan 1900
P: Los Angeles, Los Angeles, California, USA
You may, instead, choose ‘Birth and Place together’ to display both the birth date and place on the 
same line. This option wou;ld display birth infomation this way:
B: 16 Jan 1900 - Los Angeles, Los Angeles, California, USA

Notes:
You can select up to two Notes fields to be printed on the chart. You may, for example, want to print 
the individual’s address and phone.
To select a note field, click the drop-down box button on the right of the Tag1 or Tag2 field. You may 
select from the list of available Notes Tags provided. The note fields, by default, will be preceded by 
the tag name. For example, if you chose to display the persons phone number, the report will 
display:



Phone:    555-1234
You can disable the Tag name by unchecking its box. The phone number will then print without the 
Tag name.
The report will set aside a certain amout of space for your Tag note items. Indicated by ‘Lines/Note,’ 
this drop down box allows you to choose from 1, 2 or 3 lines for your notes fields. This setting will 
apply for both note fields, and provides a sharp, uniform look to the report.

ID:
The ID selection box, if checked, will display your custom ID for each individual on the report.

LDS Ordinance Codes:
If the LDS Options are on, you will have another selection box that will allow you to print the LDS 
ordinance codes. Check the box to display these for each individual.

Click OK to accept your changes, or click Cancel to discard them and return to the Reports screen.



Printing

When you are ready to print your report, simply click the PRINT button in the Reports window. You will
be able to select a range of pages, or the entire report, along with other options, depending on the 
printer you are sending the report to. When you have finished your selections, simply click OK. If you
specify a range of 4 to 6, you will get pages 4, 5, and 6. If you specify a range of 6 to 4, you will get 
the same pages, but in reverse order.

Print to File



Print to File
There are two ways to send a report to a file, for two very different purposes.
One is to use the PRINT TO FILE option on the Print dialogue box that appears after pushing the PRINT
button. This will create a file that can be copied to a printer, and will have all the codes in it for 
generating the report later. You can use this feature to create a report for a printer that you do not 
have connected to your computer. Let’s say you want to print a report on your brother’s color printer. 
You’ll need to install the driver for his printer on your system, then select that printer as the printer for
your report. Next you print the report to file. Finally, you copy the file onto a diskette. Take the disk to 
your brother’s house, where you can copy the file to his printer port using a command, like c:\>copy 
a:myfile.prn lpt1:, for example.
If you have access to a Postscript printer, you can print the report to an .EPS file using the same 
method, then you can include the .EPS file as an image inside of a document in your word processor
or publishing software (if supported), allowing you to make your report a small part of a larger 
document or presentation. This procedure may require some trial-and-error, and is limited to single 
page reports.
The other way to send your report to a file is available only for the Book reports (Ahnentafel and 
Modified Register), and the Family Reunion lists. This method allows you to bring these reports into 
a word processor.
For the Books, you will need to click the PRINT button directly from the Reports screen (the PRINT 
button on the Preview screen won’t give you this option). You will be given the choice of sending the 
report to a printer or to a file. If you choose the printer, you can then still print to a file as discussed in
option one above, or go directly to the printer. If you choose to print to file from this screen, you will 
be asked for a filename, and the book will be printed to a text file that you can then edit in your word 
processor.
The Family Reunion Contact lists will only print to a text file. Because of this, the PRINT button 
changes to OK when you are working with the Family Reunion Contact lists.



Standard Ancestry/Descendants Chart Options

Max Indent Each Generation (tenths of inch)
Choose the amount of white space (indendation) you would like between generations in tenths of an 
inch. If the number of generations to actually be printed allows for the amount specified here, this 
value will be used. On the other hand, if there are too many generations, Ancestral Quest will scale 
this value down as needed to fit all generations on a single page width.

Titles printed on each page
By selecting this option, the document title will appear on every page that is printed. Otherwise, the 
title will only appear on the first printed page, allowing you to assemble the pages into a long narrow 
chart.

Print Generation Numbers
Select this option to have the generation number print in front of each name on the chart.

Date Format
Each name on the report will include birth (or christening) date and death (or burial) date if that 
information is available. You can disable this by selecting NO DATES, or you can request that the 
YEAR ONLY be printed, or that FULL DATES be printed. Just remember, that the more information you 
ask for, the more AQ will have to abbreviate names and crunch generations together.



Ancestry/Descendants Wall Chart Options
Wall Charts may fit on a single sheet of paper, but as the name implies, the end result will likely fill a 
wall. This is usually accomplished by printing the report to several sheets, then assembling these via
manual trimming and pasting to form a single large chart. If, for example, you wish to print 15 
generations, and have chosen 3 generations per page, it will require 5 pages horizontally to produce 
each vertical page. As AQ calculates the page breaks, it will report on the number of vertical pages 
required. In this example, if 4 vertical pages are required, with 5 pages across, then a total of 20 
pages will be printed, and you will need to assemble them.
Depending on how your margins are set, you may find that AQ prints some overlapping graphics and
text at the top and bottom of sheets, to aid you in lining the pages up. You will get no overlap on the 
top of the first row of pages, or the bottom of the last row of pages.
If you leave a bit of printable area outside of your margins, AQ will print crop marks and sheet 
numbers to aid you in lining up and assembling multiple sheets. The sheet numbers will be in this 
format:    Tile (3, 2), meaning third column of sheets, second row. Occasionally, the overlap 
mentioned above may get in the way of the tile numbers, but these should normally be available on 
the top or bottom of the page.

Generations Per Page
Select the number of generations that should be printed across each page (the size of the paper you
are using). A number of one will instruct AQ to fill the entire width of the page with the information on 
a single person. A number of two will cause each person to take half of the width of the page, and so
on. You’ll find that two or three generations will work best on a standard 8 1/2” x 11” portrait page. 
You might be able to fit four generations using landscape orientation. If you have access to a printer 
that can handle wider paper, you will be able to effectively use more generations across a page.

Include Photos
Select this option to include photos with each person. Use the P  HOTOS   button to select the size of 
the photos, their placement, and whether space should be reserved for missing photos.

Print Box
Select this option to print a decorative box around the information on each individual. With this option
selected, you can click on the Box Styles button to modify the style of the box.

Select Items
Use the Select Items button to access the Wall Chart Item Selection screen. This screen will let you 
determine which specific items should appear for each person, and in some cases, how the items 
are formatted.



New
Selecting New in the File menu opens a directory dialog which will allow you to create a new family 
database, give it a name, define its path, and select a drive where it will be stored. Simply type the 
desired Family Name in the text field, select a location and drive, optionally enter the name of a new 
subdirectory, and click OK.
Here’s how to create a new database.
1. First, select the directory in which to create the database files. In the box labeled “Create 

Database files In Directory”, either type the path in which to create the database, or use the 
graphical directories box to navigate to a directory in which to create the database files.

2. EACH NEW FAMILY DATABASE MUST HAVE ITS OWN SUB-DIRECTORY. If you wish to 
create more than one database, you must create or use a different sub-directory for each new 
database. You can easily create a new sub-directory by appending the new directory name on 
the end of the currently selected name in the box labeled “Create Database files In Directory”. 
For example if you want to create a new database for the Smith family and your current selected 
directory is c:\ancquest\ you would change the directory to read c:\ancquest\smith. When you 
select OK you will be given the option to create the new directory. If you choose OK the new 
directory will be created along with the new database. Repeat this process for each new 
database you wish to create.

3. In the box labeled “Database Title”, put the name that will appear in the Ancestral Quest main 
window title when the database is opened. For example if you enter Johnson, it will read 
“Ancestral Quest - Johnson Family” in the main window title.

The created database will be 100% compatible with Personal Ancestral File® version 2.x (PAF), 
and can be used by PAF or any of the many freeware, shareware, and commercial add-on utilities 
designed to enhance PAF.
If you choose a directory where a PAF database already exists, New will warn you that the existing 
database will be replaced with empty files. If you choose to complete the process, all data in that 
subdirectory will be lost, and you will have a brand new database. This is an excellent way to flush a 
database when you need to start over.



Open
Selecting Open in the File menu, or using the CTRL+O keyboard equivalent, opens a directory 
dialog which will allow you to locate and select an existing family database.
Backup databases are saved in a different file format than normal databases. Once you have 
backed up your database using the Backup selection, you cannot open it selecting the File menu’s 
Open option. To open a backup database, use the File menu’s Restore option.

Opening an Existing Database
If you already have a PAF database, either created with this application, or with Personal Ancestral 
File, you can open it easily within Ancestral Quest. Here’s how.
1. Select Open in the File menu, click the Open button in the Toolbar, or use the Ctrl+O keyboard 

equivalent to open the Open Family dialog.

Open Database Button

2. The Open Family directory dialog will open allowing you to select the drive and subdirectory 
containing the existing family database you would like to open.

3. After you have located the database you would like to open, and the full path name is displayed 
in the open dialog box above the list of directories, simply click OK.

NOTE TO PAF USERS:    If you aren’t sure where your PAF database resides, use PAF to help 
you locate it. Here’s how:    Exit AQ and start up the Family Records portion of PAF. Next go 
to the Utilities menu. Now choose option 3, Temporarily change setup. On the first setup 
screen, you will see the directory of your current PAF database. Write this down, exit PAF 
and start up AQ. You should now be able to locate your database using the directory list box
of the Open Family window.



Backup
Select Backup in the File menu to make a backup copy of your database. This option saves your 
database in a different format that can only be accessed using the File menu’s Restore option. You 
will be asked to select a destination for the backup file. You will need to choose both a drive and a 
directory. Once your selection is shown above the directory list box, you can click OK.
When the backup is complete, you will receive a confirmation dialog indicating that your backup was 
successful. Simply click OK.
The quick way to make a backup is to use a directory on the hard disk. However, to ensure the 
safety of your data in case of a hard disk or other system failure, you should occassionally back up 
to removable disks. If your database is large, the backup will span multiple disks, prompting you to 
change them as appropriate.

Multimedia Considerations
Most other genealogy packages cannot either deal with multimedia objects, or have not developed a
standard means of sharing this information as they can with other data through a GEDCOM file. As a
result, AQ does not currently support any way of including your multimedia information in a 
GEDCOM file for sharing with others.
The BACKUP and RESTORE functions will back up and restore the index files needed as a link 
between your individuals and the multimedia objects, but they will not back up the actual multimedia 
objects. For a complete backup, you should use AQ’s backup feature to back up your genealogy 
data and multimedia linkage files, but use another backup program – like the one that came with 
your computer operating system – to backup the multimedia objects.
If you are going to try to share your entire database, multimedia objects included, with other 
relatives, you will need to provide them with both a backup of your database (so that the multimedia 
links are there), and a copy of your multimedia files. See ADD/MODIFY MULTIMEDIA ITEMS about 
relative filenames to make this work smoothly.

PAF Compatibility Considerations
The introduction of multimedia objects creates some issues that PAF (Personal Ancestral File) users 
need to be aware of.
In PAF, there are six permanent files, all stored in a common subdirectory: indiv2.dat, marr2.dat, 
notes2.dat, name2.dat namadd2.dat and reptitl2.dat. AQ uses these same six files, which is why 
AQ is 100% PAF compatible. Certain maintenance functions, specifically backup, restore, and 
database check/fix work on this list of files in a way that could cause problems if you are using the 
multimedia capabilities of Ancestral Quest.
In order to attach objects such as photos to individuals, AQ now uses two additional files that PAF 
knows nothing about. These two files are: indivex2.dat and multim2.dat. These files will not be 
created until you attach your first multimedia object to an individual in your database. From that time 
on, you will now have two more permanent files in your database. If you delete these two files, all of 
your linkages to multimedia objects will disappear, and you will have a standard PAF database 
again.
For most functions in PAF, this will not cause a problem. PAF will open the six files that it needs, and 
allow you to do all the things you are used to doing in PAF. However, if you do a backup of this 
database using PAF, your two multimedia files will not be backed up. If you are ever required to rely 
on that backup, you will lose your multimedia linkages. So if you are using multimedia objects, do
not use PAF do back up your database.
Similarly, even if you have backed up your database using AQ, if you use PAF to restore your 



database, it will miss the two multimedia files. So again, if you are using multimedia objects, do 
not use PAF to restore backups.
Finally, if you need to run a check/repair on your database, realize that PAF might take actions that 
will not keep the other six files in sync with your multimedia files. In most cases you would be OK 
running PAF’s check/repair, but there is a possibility that problems with your multimedia files could 
result. You will be best off running check/fix from AQ rather than from PAF once you have attached 
multimedia objects to your database.



Restore
Select Restore to restore a database that has been saved using the File menu’s Backup selection. 
Restore opens a directory dialog allowing you to navigate through drives and directories to locate a 
backup database. Once you have located the database you would like to restore, and the full path of
the directory is shown in the space above the directory list box, click the OK button to activate the 
restore.
The restore process will replace any data in the currently opened database, so use this 
option with extreme care.
Please see Multimedia Considerations and PAF Compatibility considerations under Backup 
for some important instructions.



Import
Selecting Import in the Data menu opens a directory dialog box allowing you to select the GEDCOM 
file that you would like to import into your database.

Importing a GEDCOM File
If you would like to import an existing GEDCOM file into a database, simply select Import in the File 
menu or click the Import button in the Toolbar.

The Import Button

The GEDCOM Import directory dialog will open.
Locate the .ged file that you would like to import and click OK. You will receive a confirmation dialog.
Click Yes to Import the file, or Cancel. You will also receive a dialog asking you if you would like to 
import available notes with the database.
Simply click Yes if you would like to import the notes, or No if you do not want to import notes.
Once the import is completed, the Windows Notepad will open, showing you the listing file created 
by the import process. The listing file will contain any information that could not be imported, such as
bad dates or names that are too long for PAF’s 16 character limitation. You can cut and paste 
valuable information from this listing file into the imported records. When you are finished looking at 
the GEDCOM listing file, close Notepad.
HINT:    You can resize Ancestral Quest and Notepad, so that you can see them side by side as you 
work, copying information from the GEDCOM listing file to the clipboard, then pasting this 
information into your database records.
Editing Keys
For a discussion on linking ancestral lines between your existing data, and your newly imported 
data, see Merge Results.



Export
Select Export in the Data menu if you would like to export your database to a GEDCOM file.
Use the Export window’s Add button to select the specific information that you would like to export, 
and select an export type. Click the Export button when you have finalized your selections.

Exporting a GEDCOM File
Ancestral Quest allows you to export your database to a GEDCOM file so that it may be imported 
into another program that supports the GEDCOM file format. Here’s how to export your database.
1. Select Export in the File menu or click the Export button in the Toolbar. The GEDCOM Export 

window will open.
2. Click the Add button to open the Export Options window. Use this window to specify exactly what

you would like to export.
3. Select your export options, and click OK. Review option descriptions below.

Search
If you would like to export descendants or ancestors of a specific individual, locate the individual 
by clicking the Search button and accessing the Find Individual window.

All
If you would like to export the entire database, simply click the All radio button and click OK to 
return to the Export window.

Family
If you would like to export the immediate family for an individual, simply locate the individual 
using the Search button and select the Family radio button.

Descendants
To export the descendants of an individual, simply locate the individual by clicking the Search 
button, and select the Descendants radio button. The Number of generations text field will 
become accessible allowing you to specify how many generations of descendants you would like
to export.

Ancestors
To export the ancestors of an individual, simply locate the individual by clicking the Search 
button, and select the Ancestors radio button. The Number of generations text field will become 
accessible allowing you to specify how many generations of ancestors you would like to export. 
You will also be able to specify the number of descendant generations to export for each 
ancestor, thereby determining how much of their posterity to include.

4. Your export selection will appear in the Export window. You can select as many different export 
options as you desire. All of your selections will appear in the Export window. To modify a 
selection, simply select it and click the Modify button to reopen the Options window.
To remove a selection, simply select it and click the Remove button.

5. Select an export type by clicking the appropriate radio button. Your export type options include 
Standard, Ancestral File, and Temple Names.

6. When you are satisfied with your selections, click the Export button to export the file. A directory 
dialog will open allowing you to select a file name and directory for the file. After you have settled
on a name and location, click OK and the export will begin. Click Cancel to cancel the operation.



To verify the contents of your GEDCOM file, see Verifying Your GEDCOM File.

Exporting Notes
GEDCOM Export gives you the option to export notes with your database if you desire. If you would 
like to export your notes with the database, make sure that the Regular Notes checkbox has been 
selected. If you would like to export source notes, select the Source Notes checkbox. If you want to 
include control notes, select the Ctrl Notes checkbox. If you would like to include the submitter 
information that you defined within the Preferences window, simply select the Submitter checkbox.

PAF Compatible vs. Advanced
A subtype for export is available, and affects only the way notes are exported. You can select either 
a PAF Compatible GEDCOM file, or an Advanced GEDCOM file. If you choose PAF compatible, your
notes will be exported exactly as they are encoded in the notes screen. If you choose Advanced, any
source tagged notes will be extracted from the notes, and placed in special GEDCOM source tags. 
This will be a preferred option if you are sending data to a friend who has software that uses some of
the proposed, advanced GEDCOM features. Since both Ancestral File and Temple Names 
submission adhere to the same GEDCOM standard as PAF, the advanced option is only available if 
you have selected a primary export type of Standard GEDCOM. If you are sending data to a friend 
with PAF or a PAF compatible program you should avoid using the Advanced subtype.



Exit
Select Exit to quit the Ancestral Quest application.



Close
Select Close to close all files in the currently open database. The only practical time you will want to 
do this is if you are working with databases on floppy diskettes. In this case, you should always close
a database before removing a floppy, then if you have other databases to work on, insert the new 
floppy, or select the database on your hard drive, and open the new database.



Temple Names Submission -- Considerations
There are some special considerations you will want to keep in mind when preparing names for 
Temple Submission:

1) Make sure your database is in good condition. If there are database problems, you may find 
that erroneous information is sent on to the Temple. It would be a good idea to verify the 
condition of your data by running the database check. If there are problems with your 
database, you will first want to backup your database, then run database check/fix.

2) The Church of Jesus Christ of Latter-day Saints recommends that if a person you are 
submitting was born within the last 95 years, you should obtain permission from the person's 
closest living relative. This relative often wishes to receive the ordinances in behalf of the 
deceased or designate someone to receive them. In some instances, the relative may wish to 
postpone the performance of the ordinances.
Please be aware that acting in conflict with the wishes of the closest living relative can result in
bad feelings toward you and the Church.
If you have selected any records of people born in the last 95 years, you may want to cancel 
the current export and adjust your selections.

3) You may feel unsure that you have selected exactly the individuals you desire for submission. 
You can take an intermediate step to verify and adjust the records contained in your 
submission. See verify GEDCOM.



Temple Names Submission -- Instructions
Once you have created the file to submit to the temple, you will want to follow these guidelines, 
proposed by the Church of Jesus Christ of Latter-day Saints (You no longer mail your Temple 
Names Preparation diskette to Church headquarters.):
1) Make sure your file is on a floppy disk. If you did not create your temple names GEDCOM file 

on a floppy disk, you will need to copy it onto a floppy.
2) Label your Temple Names Preparation diskette.
3) Take your Temple Names Preparation diskette and at least two blank, formatted diskettes to a 

meetinghouse or family history center that has a computer equipped with FamilySearch(R).
4) Use the TempleReady(TM) program to prepare your names for the temple. TempleReady will 

guide you in preparing and saving your names on a diskette to send to the temple.
5) Take or mail your submission diskette to the temple of your choice.
6) If you need additional help, contact your ward family history consultant.



Verifying Your GEDCOM File
During the process of selecting individuals, families, and ancestral and descendant lines for 
GEDCOM export, you sometimes are still not sure of exactly which individuals might have qualified. 
There is a simple way to check, and even ‘fine tune’, the contents of any GEDCOM file.
1) Create a new database in either a new subdirectory, or in an existing subdirectory that doesn’t 

have an Ancestral Quest database with critical data. (It would be a good idea to create one 
directory on your disk to use over and over for verifying GEDCOMs, perhaps “c:\ancquest\
data\verify”.) We will refer to this special directory and database as the VERIFY database.
If there is already an old VERIFY database in this special directory, you will need to use the NEW
option of the FILE menu to clear the database before continuing. DO NOT CLEAR ANY 
ANCESTRAL QUEST DATABASE THAT CONTAINS VALUABLE DATA!

2) Import the GEDCOM file you want to verify into this VERIFY database.
3) Open and browse the VERIFY database. Remove any extra individuals and families that you do 

not want to be part of the final GEDCOM file. If you cannot find some individuals you want to 
be part of the GEDCOM file, go back to your main database, create a new GEDCOM file with 
those missing individuals, then import that GEDCOM file into this same VERIFY database. 
Depending on the steps you took, you may have to merge some individuals. When this 
process is finished, you should be able to verify that all of the information you expect to be on 
the GEDCOM file is there.

4) If you have made no changes, then the initial GEDCOM file is verified, and ready to send. If 
you have made changes, you will now want to export the entire VERIFY database, by selecting 
‘All’ on the Export Options screen.



Find Individual Screen
There are two means of finding a record in Ancestral Quest:
1. If you are familiar with the record numbers, enter the record number in the RIN:/MRIN: box, 

make sure the desired type (Individual RIN or Marriage RIN) is selected, and hit return, or click 
the OK button.

Valid Range
Deleted Records

2. If you do not know the record number of the desired record, select the type of record you are 
looking for (Individual or Marriage) and select the browse button. This will activate a screen 
listing all records in the file, from which you can choose a record.

Individual Search
Marriage Search

The Marriage RIN option is not always available in the Find Individual window. It is only 
available when searching by marriage is a logical and therefore available option.



Merge
Selecting Merge in the Tools menu opens the Merge Individuals window. You will receive a warning 
dialog before performing any merge operation. The warning suggests that you back up your 
database before you begin. Simply click OK to bypass the message, and then either continue with 
the operation, or click the Close button to close the window and back up your database.

We recommend that you make a backup of your database before you begin merging 
so that you can recover if a mistake is made.

Be sure that you understand fully how to use this feature before beginning, as it is 
possible that important records could be deleted, if handled improperly.

It is important that you realize that when two records are merged, the ‘duplicate 
individual’ will be deleted. Be cautious in your merge selections so that important 
information is not destroyed, such as notes or marriage information about an 
individual that may not have been repeated in the ‘primary individual’ record.

Merging Records
Use this window to locate similar records within your database, and merge them into one record 
when appropriate.
If you have several databases, suspect you have duplicates within a single database, or have 
imported databases from others that are similar to your own, you may want to merge records. 
Ancestral Quest allows you to merge two records into one, and lets you decide which information 
from each record you would like to save. Each individual within your database is a record.
To access the Merge Individuals window, simply select Merge in the Tools menu or click the Merge 
button in the Toolbar.

The Merge Button

The Merge Individuals window will open.
When you first open the Merge Individuals window, it will be empty. The left side of the window is 
where the Primary Individual will be displayed. The Primary Individual will become the record that is 
saved when two records are merged.
The right side of the window is where the Duplicate Individual will be displayed. The Duplicate 
Individual is the record that will be removed from the database during a merge.
Ancestral Quest can either execute an automatic search of your database for duplicates matching 
certain criteria, or you can manually select a suspect record as the Primary Individual, and perform a
search for duplicates of that specific record.

Automatic Searching
To scan the database for records meeting specified duplication criteria, simply click the Next Match 
button. The application will quickly scan the records within your database attempting to locate 
possible duplications. Duplicates are determined by first and last names that sound alike and are of 
the same gender, and that one is not the parent of the other.
There are five buttons that you will use to operate the automatic searching capability:

Search
When you first open the Merge screen, all fields will be blank, allowing you to start searching 
from the front of the file. If you want to start with some other point in the file, use the S  EARCH   
button on the left side of the screen to find a person to start with. Initially this will be set for the 
primary person on the main pedigree screen, but you can change it to anyone in your file.



Next Match
The NEXT MATCH button will start searching with the next person in the database. If you want to 
see if there are any duplicates for the current person on the left side of the screen, use the NEXT
DUPLICATE or PREVIOUS DUPLICATE buttons on the right side of the screen.

Previous Match
The PREVIOUS MATCH button will start searching with the prior person in the database. If you 
want to see if there are any duplicates for the current person on the left side of the screen, use 
the NEXT DUPLICATE or PREVIOUS DUPLICATE buttons on the right side of the screen.

Next Duplicate
The NEXT DUPLICATE button will search for any more duplicates for the current person on the left
side of the screen. This will look for individuals who appear in the file after the current person.

Previous Duplicate
The Previous Duplicate button will search for any more duplicates for the current person on the 
left side of the screen. This will look for individuals who appear in the file before the current 
person.

Using these five buttons, you can specify which part of the file you want to work in, then search 
forward or backward through the file from that point. The next and previous match buttons will only 
find the first duplicate for an individual – if you believe there is more than one duplicate for an 
individual, use the next and previous duplicate buttons to see these additional duplicates.

Merge Options
You can add additional criteria to narrow the possible matches by clicking the Options button to open
the Automatic Match Options window.
Use the checkboxes to select or deselect options that you would like to include when searching for 
matches.
After you have made you selections, simply click the Next Match button to begin the automatic 
search. Once a match has been located, you can continue clicking the button to display the next 
match, and so on.

Merge Options

Automatic ID Merge
If you would like to search the database for records with identical IDs (usually Ancestral File 
numbers, or Ahnentafel numbers) and merge them automatically, simply click the Auto Merge on ID 
button. The application will immediately begin searching the database for individuals of the same sex
that have the same ID number. Whenever a match is found, the lower RIN will become the primary 
and the higher RIN will become the duplicate. See AutoMerge Confirmation for more.

Searching
If you would like to search for a specific record and display it as either the primary or duplicate 
individual, click the Search button on the appropriate side of the window.
Use this option to manually specify records that you would like to see and compare within the 
window. This is a good way to view and compare recorded information, even if you do not plan to 
merge the two records. 

Viewing Marriages
Once a primary and duplicate individual are displayed, you can access a complete list of marriages 
for both individuals. Click the Marriages button to open the Merge Individuals Marriage window.



Use this window to view marriages for both individuals. Select marriages associated with the 
duplicate individual that you would like to merge into the primary. The Marriages button becomes 
Individuals in this screen, allowing you to switch back and forth between this and the standard 
Merge window.

Editing a Record
If you would like to edit an individual’s information from within the Merge window, simply click the 
Edit button located beneath the individual that you would like to edit. The individual’s information 
window will open allowing you to edit the individual.

Switching
Use the Switch button to switch the primary and duplicate records on the screen. Simply click the 
Switch button and the duplicate record will become the primary individual -- the record which will be 
retained.

Merging
To perform a merge of two records, click the MERGE button. The marked fields of the duplicate record
will be copied into the primary record, and the duplicate individual will then be deleted. The MERGE 
button will only be available if the two individuals displayed can be merged. If the MERGE button is 
grayed out, check to make sure that the individuals both have the same sex, and that one is not a 
parent of the other.

Selecting Data to Merge
Each time the duplicate individual changes, Ancestral Quest will automatically suggest the data 
items that should be moved from the duplicate to the primary individual. These items will be 
indicated by the checkmark next to them, or in the case of marriages by the spouse being 
highlighted. You can override these defaults by 1)using the Select All button to select all fields in the
duplicate record, 2) using the Clear All button to clear all selections, or 3) individual select or clear 
fields by adjusting the check boxes, or the highlight status on the spouses.



Preferences
Select Preferences in the Tools menu, or use the Ctrl+P keyboard equivalent to open the 
Preferences window. The Preferences window is the control screen for Ancestral Quest. 
Preferences are saved with each family database, making it possible to customize specific 
preference options where appropriate, for each database.
Click the OK button to save changes you have made within the Preferences window. Click Cancel to 
ignore your changes and return to the main window.
Preferences are grouped into six categories (Database, General, InfoBox, Submitter, Fonts and 
Multimedia), selectable by clicking on the appropriate tab

Database Preferences
The Database Preferences section is the first tab of the Preferences screen. It allows you to specify 
starting RIN and MRIN, name your database, and decide which RIN you want to appear in the 
primary position when you open your database. It also allows you to select the alphabetic 
maintenance option for this database.

General Preferences
The General Preferences section is the second tab in the preferences screen. The options you 
choose here will affect all databases you work with. It contains the Append to Names options, 
several other options that can be turned on and off, the access button to the submitter screen, and 
the Info Box options. Use the Append to Names portion of the Preferences window to select what, if 
anything, you would like to appear next to the names within your family database. By default, the 
RIN will be selected. 

Info Box
This third tab in the Preferences window sets your options for the Info Box that pops up on AQ’s 
main pedigree screen.
Info Box Preferences
SubmitterClick the fourth tab to bring up the Submitter section where you will be able to enter 
information about yourself, including your name, address, and home phone number. This information
will appear in the Submitter field when a genealogical report is printed for submission to another 
party or exported as a GEDCOM file.
If you are upgrading from version 1.0 of Ancestral Quest, you will need to re-enter your submitter 
information for each database, due to an internal database adjustment between the versions relating
only to the storage of submitter information.

Fonts
The fifth tab brings up the default options for fonts. The new Fonts preferences allow you to change 
the fonts for the main pedigree screen, and for the display of notes both in the Notes edit screen, 
and on reports.

Multimedia
The Multimedia section is the sixth and final tab of preferences. It allows you to make some system 
wide adjustments to the way multimedia objects are treated.



Database Check/Repair
Select this option occasionally to run an automatic check of your database. This selection will scan 
your database searching for internal problems, and then attempt to fix the problems. Problems may 
well be transparent to you, but need to be fixed to ensure the integrity of your database.
If you would like to select another database to check, simply click the Change button and locate the 
desired database.

Check Only
If you use the Check option, you will be asked to give the report a name and a directory location, and
the check will begin. After the check has completed, Notepad will open automatically to display a list 
of errors found.

Check and Repair
If you choose the Check and Repair option, you will be asked to give the report a name and a 
directory location, and the check will begin. After the check/repair has completed, Notepad will open 
automatically to display a list of errors found, and the status of the error, i.e. (fixed).
You may wish to include foreign characters in names and place names. The PAF database 
considers these special characters to be illegal. If you use such special characters, the 
Check/Repair tool will notice these, and suggest that you have some illegal characters. You can 
choose to correct these (such characters will be removed) or leave these on a name by name basis, 
or fix them all or leave them all.
WARNING:    It is possible that a check and repair could scramble your database. You should always
make a backup copy of your database before running Check/Repair!

Check Report
Whether you do a Check Only, or a Check and Repair, you will be asked for a filename, where 
information will be stored about any problems found. This file can later be viewed in a word-
processor, or printed for review. AQ will initially try to load it into Notepad for your viewing, but will not
be able to if the file becomes too large, so you will need to access it on your own in that case.
There are a myriad of possible problems that could occur, but they fall into a few common general 
situations:
The header record of a file indicates a different number of records than the size of the file indicates. 
You may be asked in this case to choose between the two conflicting sizes. It is a good idea to 
occassionally check the About Ancestral Quest screen, under the Help menu for the number of 
records in the Individual and marriage files. This way, you will be able to make an educated guess 
when responding to this problem.
A marriage record number may point to a deleted marriage, or a marriage record that is out of the 
range of possible marriages. AQ will report this error, and remove the reference to a marriage for this
situation. You will be given the record number of the individual or marriage that contained this invalid 
marriage number, and will need to examine that individual or marriage to see if you need to relink a 
marriage.
Similarly, an individual record number may be invalid, and you will need to check the marriage or 
individual number provided to see if there is any relinking that needs to take place.
Notes are more difficult. The database has no mechanism for repairing notes. If a note pointer 
becomes corrupted, this will cause a loss of all subsequent notes for the individual, but AQ cannot 
tell which individual contained the notes. As a result, you will get the contents of the lost notes in the 
report, but will have to manually determine which individual they belonged to, and then cut the notes 
from this report, and paste them back into the individual’ notes.
Name problems can be of two flavors. The individual or marriage record contains a pointer to an 



invalid name, and you will need to check this individual or marriage for the correctness of both 
individual and place names. Or the name file itself can have internal problems. Some of these, such 
as foreign characters, may just generate warnings. But if AQ needs to actually change anything, it 
will completely rebuild the names file. In any case, the numbers presented will be name record 
numbers, not numbers of the individuals or marriages that use the name. AQ currently has no way 
for you to make reasonable sense out of these numbers, so you may want to ignore them.



Individual Browse
A complete list of names is available in a scrollable window. You can choose to sort the names either
by RIN or alphabetically by surname. Simply click the appropriate radio button next to the word Sort.
If the names have been sorted alphabetically in the list, you can quickly locate a name either by 
scrolling through the list, or typing first few letters of the surname in the text field. If you have sorted 
the list by RIN, simply type the desired RIN in the text field to highlight it in the list.
If you select a name in the list, any information that has been recorded about that individual will 
appear to the right of the list. This will help you determine if the person you have highlighted is the 
person for whom you search.
Once you have identified the individual you are searching for, either double-click the correct name, 
or click the OK button to accept the highlighted individual.
If you enter this screen from a typical browsing situation (the Main Pedigree or the Family screen), 
you will be allowed to edit and/or delete individuals. This gives you the option of working with 
individuals in your data in one of three modes: Pedigree (Main Pedigree screen), Family Group 
(Family screen), or by numeric or alphabetic listing (this Individual Browse screen).
You can also edit notes for the highlighted person while in this screen.
By choosing the Media button, you can view and modify the media collection for an individual.
If you edit an individual while in the browse screen, and change the name, the change will only be 
reflected on the current line. If you change the case of the name, for example from “Jones” to 
“JONES”, you will only see the currently selected person’s name change, although all occurrences of
“Jones” in the database will now be changed to “JONES.” If you will scroll the list up and down, so 
that the names have to be refreshed, you will see that this has occurred. Also, if you are looking at 
an alphabetic listing, and the change would cause the individual to change positions in the list, this 
change of position will not take place until you scroll the list around.



Marriage Browse
A complete list of marriages and marriage dates is available in a scrollable window, sorted 
numerically by MRIN. Either scroll through the list to locate the marriage, or type a MRIN in the text 
field at the top of the window to highlight the marriage within the list.
Once you have identified the marriage you are searching for, either double-click the correct line, or 
click the OK button to accept the highlighted marriage.



Merge/Duplicates Options

Include Individuals with no Surname?
Select this checkbox if you would like to include records that do not contain surname information. By 
default, individuals without surnames are not considered as matches.

Include Individuals with no Birth Date?
Select this checkbox if you would like to include records that do not contain birth date information.

Years between birthdates
Use this field to enter a span of years which you will allow when searching for a possible match.

Before you use the following options, you should understand the way the application 
“considers” information for matches. If both records have data in the mentioned field (ID 
or parents, for example) then the data must match for the two records to be considered a 
match. If either record is missing the data (the field is blank), that criteria will not be 
included as a consideration when determining a match.
When considering parents and middle names, the data entered in the text field must 
sound alike, not necessarily be spelled identically to constitute a match.

Consider IDs
Select this checkbox if you would like to consider the customized ID saved with the record when 
searching for a possible match.

Consider middle names?
Select this checkbox if you would like to consider names that have been entered in a Given Names 
field other than the first name.

Consider parents?
Select this checkbox if you would like to consider the parents when determining a possible match. 
This option is selected by default.

Combine notes?
Select this checkbox if you would like to combine any notes that have been saved with a duplicate 
record with the Primary Individual when you merge the records. This option is selected by default.
This option is not meaningful when selecting options for the Duplicates report.



Submitter Information
Click the Submitter tab to access the section where you will be able to enter information about 
yourself including your name, address, and home phone number. This information will appear in the 
Submitter field when a genealogical report is printed for submission to another party, or exported as 
a GEDCOM file. Each database stores submitter information, so you will need to enter this data for 
each database you have.



Search
While working with Ancestral Quest, you will want to find a specific individual or family to view, edit, 
report on, or whatever. Almost every screen has the ability to find an individual, and some screens 
allow you to locate a family.
The search function allows you to enter a record number if you know it, or search through a list of 
records if you do not know the number. For marriages, this list is a numerically sorted list by MRIN, 
and for individuals, you can sort the list by RIN or alphabetically.
While on the main screen -- the 5 generation pedigree with the menu and toolbar -- you select 
search by pulling down the Tools menu and selecting Search, or by using the CTRL+S keyboard 
equivalent, or by clicking the search tool (it looks like a pair of binoculars).

 Search
From all other screens, you select the Search button.



InfoBox Preferences
Use the Info Box preference options to select the way you would like to display information while the 
Pedigree window is active. There are two ways that information can be displayed, either within a 
floating box that pops up when you lay your cursor over the name of an individual, or a locked box 
that appears only when you click the square containing an individual’s name.

Floating Info Box
Choose the desired option, None, Dates Only, or Dates and Family Info for the type of 
information box you want to appear as you move your mouse over the name.
In the Wait Time field, enter the amount of time that should elapse after the mouse enters a 
name field before the floating box should appear. The default is 5/10, or 1/2 second. You can 
make the box come up instantly by entering 0, or enter any value up to approximately 600/10, or 
60 seconds. You may need to play with this wait time option to see how it affects the way you 
work with the pedigree screen. Experiment!

Locked Info Box
Choose the desired option, None, Dates Only, or Dates and Family Info for the type of 
information box you want to appear as you select the name.



InfoBox
The information box is a little popup window that works with the pedigree screen to allow you to see 
more information on an individual. There are several options for adjusting the way it works for you. 
(See InfoBox Preferences). You may decide that the box is in your way, so you can even disable it.
The upper half of the box contains the birth and death date and place, and the date and place of the 
currently selected marriage, along with the MRIN.
If the LDS Data option is turned on, some of the room in the death place field is reserved to show 
completed LDS Ordinance codes.
If you choose the Dates Only option for an infobox, you will see only this upper half of the box.
The lower half of the box contains a dropdown list box of all of the spouses of the individual. The 
marriage date, place and MRIN shown in the upper half is the data for the marriage with the 
currently selected spouse in this box.
Directly below this spouse list box is a list box showing all children of the currently selected 
marriage.
You can use the scroll bars to view any spouses or children that are not visible in these list boxes.
If you choose the Dates and Family Info option for the infobox, you will see both the upper and lower
portions of this box.
Whenever the family information is shown in the Info Box, the status bar of the main pedigree screen
will also show you how many marriages the highlighted person has, and how many children in the 
current marriage.



InfoBox: None
Select None, if you do not want to display additional information within the Pedigree window.



InfoBox: Dates Only
Select Dates Only, if you would like to display recorded marriage, birth, and death dates within 
the pop-up window.



InfoBox: Dates and Family Info
Select Dates and Family Info, to display any recorded spouses and children, as well as marriage,
birth, and death dates within the pop-up window.
Whenever the family information is shown in the Info Box, the status bar of the main pedigree 
screen will also show you how many marriages the highlighted person has, and how many 
children in the current marriage.



Merge Results
When a merge is performed, the following happens:
1) All fields and marriages SELECTED on the Duplicate individual will be moved into the record of the

Primary individual.
2) If the parents of the Duplicate individual is selected, then the Primary individual is unlinked from 

his/her parents, and is then linked to the parents of the Duplicate individual.
3) The Duplicate individual is then deleted from the database, and the RIN of the Duplicate 

individual will be free to be used by another individual as records are later added to the 
database.

Understanding item 2 above is crucial for successful linking of family lines. For example, let’s say 
you have a Robert Smith in your ancestry, and have just imported a GEDCOM file which contains 
the same Robert Smith along with a portion of his continuing ancestry. To properly link this new line 
to your existing database, you can do one of two things:
1) Go to the Merge screen, place the original Robert Smith in the Primary position and the newly 

imported Robert Smith in the Duplicate position. Make sure you select the parents of the 
Duplicate Robert Smith. When the merge is performed, the original Robert Smith will be linked 
with the continuing ancestry brought over with the import.

or
2) In the Family screen, make the original Robert Smith the primary person and add his parents. 

You will use the Search for Existing button on the Add Individual screen to locate the newly 
imported father or mother.
Then go to the Merge screen, and put the newly imported Robert Smith in the duplicate position, 
with the original Robert Smith in the Primary position, and do the merge.



Database Problem
This screen indicates there are problems with the database that prevent other features in Ancestral 
Quest from functioning properly. Each database file contains a header which keeps track of the 
number of records in the file, if this number does not match the number of records indicated by the 
file size, Ancestral Quest will not be open the file until a repair is made. The following options will 
help in repairing the database files.

Backup
IT IS RECOMMENDED THAT A BACKUP BE MADE BEFORE A REPAIR IS ATTEMPTED. This 
backup should not replace a previous clean backup. Backup these files to a empty floppy disk or to a
suitable location on your hard disk. During the repair process you will be presented with choices on 
how to repair your database files. If the repair produces unexpected results, you can restore the 
backup and try the repair again selecting different options. If the repaired database is still 
unsatisfactory, a restore can be made from a clean backup.

Repair
After selecting repair you will be presented a dialog box which will show the name of the damaged 
file and options for repairing the file. You will be given the option to choose between the number of 
records reported by the file header or the number of records indicated by the file size. If the number 
of records reported by the header is greater than the number of records indicated by the file size, the
header will be automatically adjusted to match the file size.
An example of a repair would be: If you know there are 100 individuals in your database and the 
indiv2.dat (individuals) file header says there 10 records and the file size indicates there are 100 
records, you would choose 100 as the repaired size.

Cancel
Select cancel to load Ancestral Quest without repairing the file. The Restore option under the File 
menu can then be selected to restore the database from a CLEAN backup.



Auto Merge on ID Confirmation
The first time a match is found when using the AUTO MERGE ON ID button, you will be asked how to 
proceed. Your choices will be:

Yes Merge this set, then continue searching, and ask again on the next match.
Yes to All Merge this set, then continue searching, but don’t ask me any more. As matches are 

found, just merge them and keep going. Once you have chosen this option, you 
will not be able to cancel it. All remaining records that match on ID will be 
merged. Use this with care!

No Don’t merge this set, but continue searching, and ask again on the next match.
Cancel Stop the process. Don’t find any more matches, and don’t do any more merging.



Database Preferences

Family Name
Use the Family Name field to enter the family name that you would like to appear in the title bar next 
to the application name. This name can be whatever name you choose, either the same name as 
the database is saved under, or different name to identify it for your individual needs.

Starting RIN
Use the Starting RIN field to enter the RIN you would like your database to begin with. Ancestral 
Quest automatically begins each database with a RIN of one, but you can change this number if, for 
example, you are creating multiple databases, and you want to identify every individual with a unique
RIN.

Starting MRIN
Use the Starting MRIN field to enter the MRIN you would like your database to begin with. Ancestral 
Quest automatically begins each database with a MRIN of one, but you can change this number if, 
for example, you are creating multiple databases, and you want to identify every marriage with a 
unique MRIN.

Initial RIN on Startup
Use this section of the Database Preferences to define which RIN number you would like to appear 
in the primary position when you open the database.
Select Lowest if you would like the lowest RIN to appear in the primary position.
Select Use: if you would like to search for a RIN to appear in the primary position. The Search button
will become accessible allowing you to locate the desired RIN using the Find Individual window.
Select Last Used if you would like the same individual that appeared in the primary position when 
the database was closed to reappear when it is opened.

Maintain Alpha Index
If this is checked, the alphabetic index for this database will be maintained as long as it is up to date.
This means that everytime an individual is added, the alphabetic index will be partially re-written to 
add this new person’s name to the index. Everytime an individual is deleted, this index will be 
partially re-written to remove that person’s name from the index. And everytime someone’s name 
(surname, or first or second given name) is modified, the alphabetic index will undergo a removal of 
the old name, and an add of the new name. Certain functions will temporarily turn this off: GEDCOM 
import, Auto Merge by ID, and Database Check/Fix. When the alpha index gets out of sync with the 
database, AQ will not maintain the index until it has been resorted.
There are tradeoffs to using this feature. Checking this box will slow down such functions as adding, 
deleting and modifying individuals. But it will also mean that the alpha index will not have to be 
resorted as often.



General Preferences
Use the General Preferences section of the Preferences window to select what, if anything, you 
would like to append to names within the database, whether or not you would like to use the LDS 
Data option.

Append to Names Preferences
The Append to Names section lets you select what information, if any, you would like to appear next 
to an individual’s name within the database.
Select Nothing, if you would like individual names, and nothing else, to appear on your pedigree 
chart. For example, “Mary Louise JOHNSON.”
Select RIN (Record ID Number), if you would like the record identification number assigned to an 
individual, to appear after that individual’s name in the database. For example, “Mary Louise 
JOHNSON-1.” 
The RIN is automatically assigned by Ancestral Quest according to the order in which an individual is
entered into the database. It refers to the order in which the individual’s name was entered in the 
database.
Select ID, if you would like the customized identification recorded for an individual to appear after an 
individual’s name in the database. For example, “Mary Louise JOHNSON-4567.” The ID field is often
used for the Ancestral File Number or for an Ahnentafel ID number. The Ancestral File Number for 
an individual identifies that individual within the Ancestral File database maintained by the Church of 
Jesus Christ of Latter-day Saints.

Use LDS Data
Select the Use LDS Data checkbox, if you would like to enter additional information about an 
individual relating specifically to LDS temple work. By default, the LDS Data option is turned off.

Verify New Names
Select the Verify New Names checkbox if you would like the program to notify you when you enter 
names into the database you have not entered before. This helps you avoid misspellings. By default,
this is off, and you will not be notified when you enter a new name.

Capitalize Surnames
Select the Capitalize Surnames checkbox if you want all surnames to be capitalized throughout the 
program, except in the edit screen. If you turn this off, surnames will be displayed as you enter them.

Edit Marriage when Created
Select the Edit Marriage when Created checkbox if you would like the Marriage Edit box to come 
up immediately everytime a new marriage is created (such as when you add a parent to an 
individual, thus creating a marriage for the parent). If you turn this off, the Marriage Edit screen will 
not automatically come up, and you will need to remember to bring up the Marriage Edit screen to 
enter information about the marriage.

Shade Reports
Select the Shade Reports checkbox to allow for shading on some of the reports. Several of the 
reports have areas that can be shaded to enhance their appearance and readability. On some 
printers, the shading is done in such a way as to detract, rather than enhance, readability and 
appearance. You may want to select this option and see how your reports look, then turn this option 
off to compare the results. You can then make an educated choice. The Shade Reports option is on 
by default.



Notes Button Sections
A Notes Selector screen has been provided to help you organize your notes. There may be times 
when you feel that this screen gets in the way. The “Notes Btn while editing indiv” section allows you 
to define whether the Notes button of the Individual add/edit screen should go straight to the Notes 
screen, or present the Notes Selector screen. The “Notes Btn while browsing” section allows you to 
define how the Notes button will work in all other situations -- while browsing on the 5-generation 
pedigree screen, or browsing in the Family screen, or browsing in the search screen.
Colors
Password



Color Preferences
The colors for AQ’s main Pedigree Screen can be adjusted. From the Preferences window, select 
the General tab then click the Colors button.

The top half of the Color selection box is a preview of your color scheme. Select any portion of this 
preview by clicking on the element you wish to change, or by selecting the title of the area from a list 
box below it. Once you have selected the portion you want to change, use the Change Color button 
to activate the standard Windows color selection box. You can choose from one of the standard 
colors, or by selecting Define Custom Colors you can choose a fine-tuned color to your liking. After 
experimenting with color options, you can save them, or restore the AQ default colors – the 
background color will be the standard light gray, and the colors of the name boxes will be taken from 
your current Windows color scheme for Active and Inactive window title bars--by clicking the Default 
button..
Colors may be set for:    Name text, Name Background, Selected Name Text, Selected Name 
Background, and Pedigree Window, which is the background of the main pedigree screen.



Color Selection
You may choose a color from the samples presented windows’ standard Color selection box. Click 
the color then select OK. You may define your own custom color by clicking the button Define 
Custom Colors. From this graphical display, you can select colors visually by clicking on the palette,
or by typing in values for Hue, Saturation, Luminence, and Red, Green and Blue. One the correct 
color is displayed in the preview, click the Add to Custom Colors button. For further assistance with
color selection, consult your Windows documentation.



Font Preferences
Select the Font tab of the Preferences window to adjust some of the font defaults.

Main Pedigree Screen:
There are two fonts used by the pedigree screen – one for when the pedigree screen is maximized, 
and another for when the screen is sized smaller than your entire screen (referred to as restore by 
Windows). The font used for the maximized situation is fully selectable, within a range of sizes. By 
default, it is a raster font, which paints much more quickly than a True Type font. If you want to 
maintain the speed at which the program runs, you should choose similar fonts (not True Type) for 
your maximized font.
The Sized font is by default a True Type font, allowing the characters of the name to adjust 
themselves to the dimensions you choose for the screen, and you should choose only True Type 
fonts here. AQ will not honor the point size you choose for this font, as the font will adjust itself for 
best fit depending on how you have sized your pedigree window. You will want to experiment with 
these fonts to get a feel for how they affect your screen. You can always use the Defaults button to 
reset the fonts to the way they were when you first installed Ancestral Quest.
Notes:
This Preferences window will allow you to set the font for your Notes on both the Edit screen and on 
your printed reports. Now you can use your favorite display font, or if you are used to PAF’s fixed 
font, and use it to space out columnar data – by choosing a fixed font (which AQ now provides by 
default) you can retain the columnar layout of your notes.

Edit Screen:    This is the on-screen text entry screen. Your font can be changed for this by 
clicking on the Change button.

Reports:    You may choose a different font for your notes when they are printed on Reports.
To reset the fonts to the original defaults, click on the Defaults button in the lower left corner of the 
window.



InfoBox Preferences
There are two types of Information windows that may be displayed beneath individuals on your 
pedigree chart, a Floating Box and an On Select of Individual Box. Use the Info Box tab of the 
Preferences window to define what information, if any, you would like to appear in these pop-up 
information windows.
Use the Wait Time text field to adjust the amount of delay you would like to associate with the 
Floating Information window. The default delay is five tenths of a second.



Multimedia Preferences
Slide Show defaults are set at this screen. Click on the Multimedia tab of the Preferences screen to 
access these settings.
Display Time:
The default display time for each slide to be on-screen during a slide show is set by typing in or 
clicking the up/down buttons to select it. The time is adjustable in tenths of a second. Specific slides 
can override this default from the Edit Photo screen of the individual’s multimedia collection.
Image size:
Choose ‘default size’ to display the image at its original dimensions.
‘Fit within’ allows you set a a prefined size for all images. The photo will be resized, smaller or larger,
to fit within your set size.
Background Color:
Since slides do not always fill the screen, you can choose the color for the background of the slide 
show by clicking the Background Color button.

Photo Placeholder
When you preview reports that contain photos, the display may take extra time as it reads the photos
off your disk. Use the Photo Placeholder on Print Preview checkbox to indicate that when you are 
previewing documents, you want a gray box to take the place of the photo. This will allow you to view
the report layout more quickly.



Password
To set a password, click the General preferences tab, and select Password. This is not a highly 
restrictive type of password. You will be able to see the password as you enter it. The password is 
case sensitive – this means that if you enter “Spot” for your password, you must later enter “Spot,” 
not “spot” or “SPOT,” to gain access.
AQ will assume that since you entered the password, you must know it, so you will not be asked for 
the password during the current session. The password will be activated the next time AQ is started.
Once activated, you must enter the password to change the password, or to do anything that will 
change your data. The password can be deactivated by going back into the password screen and 
deleting all characters in the password entry field.
AQ’s password may act a little differently than what you are used to in other applications. If, during a 
session, you never try to make any changes, you will never be asked for the password. The first time
you attempt to make a change, or view the current password, you will be prompted for the password.
Once it is entered correctly, you will not be asked again during that session. If you make a mistake, 
you will be allowed up to three attempts at correctly entering the password, after which time AQ will 
presume you are not authorized to make any changes for the remainder of the session.
The password is not so secretive that you can’t be shown how to recover should it be forgotten. See 
instructions in the written manual for instructions on how to access your password.



Windows Keys

Choose from the following list to review the keys used in Windows:
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left Arrow Moves to the beginning of a field.
PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches 

the one you type.
DIRECTION key Moves from option to option within a group of options.

Or, move the cursor left, right, up, or down within a list or text 
box.

ENTER Executes a command button.
Or, chooses the selected item in a list box and executes the 
command.

ESC or ALT+F4 Closes a dialog box without completing the command. (Same as
Cancel)

ALT+DOWN ARROW Opens a drop-down list box.
ALT+UP or DOWN ARROW Selects item in a drop-down list box.
SPACEBAR Cancels a selection in a list box.

Selects or clears a check box.
CTRL+SLASH Selects all the items in a list box.
CTRL+BACKSLASH Cancels all selections except the current selection.
SHIFT+ DIRECTION key Extends selection in a text box.
SHIFT+ HOME Extends selection to first character in a text box.
SHIFT+ END Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.

SHIFT+DEL or Ctrl+X Cuts selected text out of your current window into the clipboard.
Ctrl+INS or Ctlr+C Copies selected text from your current window into the 

clipboard.
SHIFT+INS or Ctlr+V Pastes text from the clipboard into your current window.



Menu Keys

Key(s) Function

Alt or F10 Selects the first menu on the menu bar, or if selected, returns to
the application.

Letter key Chooses the menu, or menu item, whose underlined letter 
matches the one you type.

Alt+letter key Pulls down the menu whose underlined letter matches the one 
you type.

LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
Enter Chooses the selected menu item.
Esc Close the open menu.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
SHIFT+ALT+TAB Switch to previous applications.
Print Screen Copies the entire screen to the Clipboard.
Alt+PrtSc Copies the entire active window to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left 
or right.

SHIFT+DOWN or UP Selects one line of text up or down.
SHIFT+END Selects text to the end of the line.
SHIFT+HOME Selects text to the beginning of the line.
SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

SHIFT+PAGE UP Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.
CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or 

end (DOWN ARROW) of the paragraph.
CTRL+SHIFT+END Selects text to the end of the document.
CTRL+SHIFT+HOME Selects text to the beginning of the document.



Window Keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+ENTER Switches a non-Windows application between running in a 

window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.






